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REFERENCES

CONVENTIONS
This manual uses the following conventions:

"User" refers to anyone using a Matrix 400™ reader.

"Reader" refers to the Matrix 400™ reader.

"You" refers to the System Administrator or Technical Support person using this manual to
install, configure, operate, maintain or troubleshoot a Matrix 400™ reader.

REFERENCE DOCUMENTATION

For further details refer to: the VisiSet™ Help On Line, Matrix Reading Methods, Matrix Host
Mode Programming, Matrix SW Parameter Guide, Matrix Code Quality Verifier Solution
provided as supplementary documentation on CD-ROM.

SERVICE AND SUPPORT

Datalogic provides several services as well as technical support through its website. Log on
to www.automation.datalogic.com and click on the links indicated for further information
including:

e PRODUCTS

Search through the links to arrive at your product page where you can download specific
Manuals and Software & Utilities

- VisiSet™ a utility program, which allows device configuration using a PC. It provides
RS232 and Ethernet interface configuration.

e SERVICES & SUPPORT

- Datalogic Services - Warranty Extensions and Maintenance Agreements

- Authorised Repair Centres

e CONTACT US

E-mail form and listing of Datalogic Subsidiaries

PATENTS

This product is covered by one or more of the following patents:

U.S. patents: 6,512,218 B1; 6,616,039 B1; 6,808,114 B1; 6,997,385 B2; 7,102,116 B2;
7,282,688 B2

European patents: 999,514 B1; 1,014,292 B1; 1,128,315 B1.
Additional patents pending.
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COMPLIANCE

For installation, use and maintenance it is not necessary to open the reader.

EMC COMPLIANCE

In order to meet the EMC requirements:

e connect reader chassis to the plant earth ground by means of a flat copper braid shorter
than 100 mm;

o for CBX connections, connect the pin "Earth" to a good Earth Ground

o for direct connections, connect the main interface cable shield to pin K of the 19-pin
connector;

POWER SUPPLY
ATTENTION: READ THIS INFORMATION BEFORE INSTALLING THE PRODUCT

This product is intended to be installed by Qualified Personnel only.

This product is intended to be connected to a UL Listed Computer which supplies power
directly to the reader or a UL Listed Direct Plug-in Power Unit marked LPS or “Class 27, rated
10 to 30 V, minimum 1 A.

LED CLASS
Class 1 LED Product to EN60825-1:2001

CE COMPLIANCE

Warning: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

FCC COMPLIANCE

Modifications or changes to this equipment without the expressed written approval of Datalogic could
void the authority to use the equipment.

This device complies with PART 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference which may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

Vii



HANDLING

The Matrix 400™ is designed to be used in an industrial environment and is built to withstand
vibration and shock when correctly installed, however it is also a precision product and
therefore before and during installation it must be handled correctly to avoid damage.

o avoid that the readers are dropped (exceeding shock limits).

. do not fine tune the positioning by striking the reader or bracket.

viii



do not weld the reader into position which can cause electrostatic, heat or reading
window damage.

do not spray paint near the reader which can cause reading window damage.




GENERAL VIEW

Matrix 400™

e

o

B P Ry N - [y -

@ Device Class Label

(2) Mounting Holes (12)

@ Lens Cover

@ Lens (separate accessory)

@ Internal llluminator (separate accessory)

Figure A

@ HMI X-PRESS™ Interface
@ "POWER ON" LED
Power - Serial Interfaces - /0O Connector

@ Ethernet Connector (Ethernet Models Only)

@ Ethernet Connection LED
(Ethernet Models Only)
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1 RAPID CONFIGURATION

STEP 1 — ASSEMBLE THE READER

The first step to perform is to assemble the accessories that make up the Matrix 400 ™
reader. The lens and either an internal or an external illuminator must be used. This
procedure shows an internal illuminator.

& Matrix 400™ must be disconnected from the power supply during this

procedure.
CAUTION

1. In a dust-free environment, remove the Matrix 400™ Lens Cover by unscrewing it.

& Do not touch the sensor aperture, lens glass or lens cover glass. These
areas must be kept clean. Avoid any abrasive substances that might damage
CAUTION these surfaces during cleaning.

Remove the sensor protection label by pulling it off of the base.

Mount the lens by screwing it tightly onto the base.

If using an internal illuminator:

a. Mount the 4 internal illuminator spacers into the holes provided on the base.

b. Align and mount the Illuminator board tightly onto the spacers using the 4 screws
provided in the illuminator package. The spacers are positioned asymmetrically to
avoid incorrect alignment.

5. To keep dust and dirt off of the lens during mounting, temporarily replace the lens cover.

Locking Knobs  Internal
llluminator

Lens Cover

Figure 1 — Assembling Matrix 400™ Accessories
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Required Accessories

The following table shows the correct lens/illuminator combinations to be used for Matrix
400™ imager assembly.

Lenses Internal llluminators
93ACC1793 |LNS-1006 |6 mm C-Mount Lens 93A401020 |LT-002 Red Wide Angle
(only for Matrix 400 600-0x0 models) | 93A401022 | LT-004 White Wide Angle
93ACC1794 |LNS-1109 |9 mm C-Mount Lens 93A401020 |LT-002 Red Wide Angle
93A401022 | LT-004 White Wide Angle
93ACC1795 |LNS-1112 | 12.5 mm C-Mount Lens 93A401020 |LT-002 Red Wide Angle
93A401022 | LT-004 White Wide Angle
93ACC1796 |[LNS-1116 |16 mm C-Mount Lens 93A401019 ([ LT-001 Red Narrow Angle
93A401021 [ LT-003 White Narrow Angle
93ACC1797 |[LNS-1125 |25 mm C-Mount Lens 93A401019 | LT-001 Red Narrow Angle
93A401021 [ LT-003 White Narrow Angle
93ACC1798 |[LNS-1135 |35 mm C-Mount Lens 93A401024 [ LT-006 Red Super Narrow Angle
93ACC1799 [LNS-1150 |50 mm C-Mount Lens 93A401024 | LT-006 Red Super Narrow Angle

STEP 2 — CONNECT THE SYSTEM

To connect the system in a Stand Alone configuration, you need the hardware indicated in
Figure 2. In this layout the data is transmitted to the Host on the main serial interface. Data
can also be transmitted on the RS232 auxiliary interface independently from the main
interface selection.

When One Shot or Phase Mode Operating mode is used, the reader is activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

CAB-MS01 |

PG 6000

CBX

Main Interface

Matrix 400™

*

[ ] P.S.

| © |
—

-

o = = = |

4 =

* External Trigger or Presence Sensor

110, AUX (for One Shot or Phase Mode)

Figure 2 — Matrix 400™ in Stand Alone Layout
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CBX100/CBX500 Pinout for Matrix 400 ™

The table below gives the pinout of the CBX100/CBX500 terminal block connectors. Use this
pinout when the Matrix 400™ reader is connected by means of the CBX100/CBX500:

CBX100/500 Terminal Block Connectors
Input Power Outputs
Vdc Power Supply Input Voltage + +V Power Source - Outputs
GND | Power Supply Input Voltage - -V Power Reference - Outputs
Earth | Protection Earth Ground O1+ Output 1 +
0O1- Output 1 -
Inputs 02+ Output 2 +
+V Power Source — External Trigger 02- Output 2 -
1A External Trigger A (polarity insensitive) Auxiliary Interface
1B External Trigger B (polarity insensitive) TX Auxiliary Interface TX
-V Power Reference — External Trigger RX Auxiliary Interface RX
+V Power Source — Inputs SGND | Auxiliary Interface Reference
12A Input 2 A (polarity insensitive) ID-NET™
12B Input 2 B (polarity insensitive) REF Network Reference
-V Power Reference — Inputs ID+ ID-NET™ network +
Shield ID- ID-NET™ network -
Shield | Network Cable Shield
Main Interface
RS232 RS485 Full-Duplex RS485 Half-Duplex
TX TX+ RTX+
RTS TX- RTX-
RX *RX+
CTS *RX-
SGND SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.

Do not connect GND, SGND and REF to different (external) ground
references. GND, SGND and REF are internally connected through filtering
circuitry which can be permanently damaged if subjected to voltage drops

CAUTION over 0.8 Vdec.
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19-pin Connector Pinout for Matrix 400 ™

The table below gives the pinout of the 19-pin M16 male connector for connection to the
power supply and input/output signals. Use this pinout when the Matrix 400™ reader is
connected by means of the 19-pin connector:

Figure 3 - 19-pin M16 Male Connector

19-pin M16 male connector pinout

Pin Name Function

A Vdc Power supply input voltage +

L GND Power supply input voltage -

K CHASSIS Cable. shield internally connected by capacitor to the

chassis

B 1A External Trigger A (polarity insensitive)

C 1B External Trigger B (polarity insensitive)

D 12A Input 2 A (polarity insensitive)

E 12B Input 2 B (polarity insensitive)

H o1+ Output 1 +

F O1- Output 1 -

G 02+ Output 2 +

I 02- Output 2 -

S RX Auxiliary RS232 RX

@) X Auxiliary RS232 TX

R ID+ ID-NET™ network +

P ID- ID-NET™ network -

. RS485 RS485
Pin Name RS232 Full-Duplex Half-Duplex
M MAIN TX TX+ RTX+
U INTERFACE RX *RX+

N (SW RTS TX- RTX-
T SELECTABLE) CTS *RX-

* Do not leave floating, see par. 5.4.2 for connection details.
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STEP 3 - MOUNT AND POSITION THE READER

1. To mount the Matrix 400™, use the mounting brackets to obtain the most suitable
position for the reader. Two of the most common mounting configurations are shown in
the figures below. Other mounting solutions are provided in par. 3.3.

Figure 5 —Positioning with Mounting Bracket (Side)

2. When mounting the Matrix 400™ take into consideration these three ideal label position
angles: Pitch or Skew 10° to 20° and Tilt 0°, although the reader can read a code at any tilt
angle.

[t \-
\LS ’J T

Assure at least 10°

Minimize

Figure 6 — Pitch, Skew and Tilt Angles
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3.

Refer to the Reading Features table in chp. 7 for FOV calculation and minimum
distance requirements according to the base/lens combination used for your
application.

@ Rapid Configuration of the Matrix 400™ reader can be made either through

NOTE (o your needs.

the X-PRESS™ interface (steps 4-6) which requires no PC connection, or by
using the VisiSet™ Setup Wizard (steps 7-8). Select the procedure according

STEP 4 - FOCUS THE READER

Matrix 400™ provides a built-in tool called Blue Diamonds™ to aid focusing the reader. The
Blue Diamonds™ are accessed through the X-PRESS™ Interface.

1. Remove the lens cover in order to focus the reader.
2. Prepare the correct accessory lens for your application:
a. Loosen the two Locking Knobs on the lens.
b. Adjust the Focus ring to the "Far position" and the Diaphragm ring to the "F4™"
number setting which is the preferred setting for installation.

3. Power the reader on. During the reader startup (reset or restart phase), all the LEDs blink
for one second. On the connector side of the reader near the cable, the “POWER ON”
LED (blue) indicates the reader is correctly powered.

4. Enter the Focus function by pressing and holding the X-PRESS™ push button until the
Focus LED is on.

5. Release the button to enter the Focus function. The Blue Diamonds™ turn on.

READY
The procedure is as follows: green
GOOD
A) Adjust the Focus ring towards the "Near position" until
the Blue Diamonds™ are perfectly in focus, see 97"
Figure 8. TRIGGER
. yellow @ rocus
At long focal distances a "skew" angle may cause a com
noticeable difference in focus between the two
diamonds, in this case select the best possible focus yellow

(both diamonds slightly out of focus). STATUS
Tighten the Focus Locking Knob. red _@ @
B) Tighten the Diaphragm Locking Knob. Figure 7 — X-PRESS™ Interface:

Focus Function

@ If necessary you can use the Fine Focusing Tool in the VisiSet™ Setup Wizard

NOTE

for fine focusing. See Step 8.

! For far reading distances, the Diaphragm ring can be set to values between F2 and F4 to increase image lighting and Blue
Diamond™ visibility.

6
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FOV

Blue Diamond™
in focus

Figure 8 — Focus Function Using Blue Diamonds™

6. Exit the Focus function by pressing the X-PRESS™ push button once. The Blue

Diamonds™ turn off.

7. Replace the lens cover, screwing it tightly to the base.

STEP 5 — CALIBRATE IMAGE DENSITY

In order to function correctly to the fullest extent of its capabilities, Matrix 400™ must acquire
information regarding image density or PPI (pixels per inch). This calibration takes place
through the X-PRESS™ Interface and the Grade A Barcode Test Chart included in the
package. This procedure is necessary for the first time installation, if the lens type is changed
or if the focal distance is changed.

Locate

1. Enter the Focus function by pressing and holding the
X-PRESS™ push button until the Focus LED is on.

2. Release the button to enter the Focus function. The

Blue Diamonds™ turn on.

3. From the Grade A Barcode Test Chart, select the

longest code whose length fits between the two Blue
Rotate the code 90 degrees and
position the code at the center of the FOV

Diamonds™.,

(equidistant from the Blue Diamonds ™).

[T
(T
(T

JI20IVIVC v 3avao - 1vHD 1S3L 3000M

4. Exit the Focus function by pressing the X-PRESS™
push button once. The Blue Diamonds™ turn off.

=

READY

green LEARN

green SETUP
TRIGGER

yellow
com

yellow @ s
STATUS

o —@) (A

Figure 9 — X-PRESS™ Interface:
Locate Function
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Setup

5.

Enter the Setup function by pressing and holding the
X-PRESS™ push button until the Setup LED is on.

Release the button to enter the Setup function. The
Setup LED will blink until the procedure is
completed.

The Setup procedure ends when the Image
Acquisition parameters are successfully saved in the
reader memory, the Setup LED will remain on
continuously and Matrix 400™ emits 3 high pitched
beeps.

If the calibration cannot be reached after a timeout of
about 5 (five) seconds Matrix 400™ will exit without
saving the parameters to memory, the Setup LED will
not remain on continuously but it will just stop
blinking. In this case Matrix 400™ emits a long low
pitched beep.

Exit the Setup function by pressing the X-PRESS™
push button once.

Learn

8.

10.

Enter the Learn function by pressing and holding the
X-PRESS™ push button until the Learn LED is on.

Release the button to enter the Learn function. The
Learn LED will blink until the procedure is
completed.

The Learn procedure ends when the Image Density
value is successfully saved in the reader memory,
the Learn LED will remain on continuously, the
Green Spot is activated and Matrix 400™ emits 3
high pitched beeps.

If the calibration cannot be reached after a timeout of
about 3 (three) minutes Matrix 400™ will exit without
saving the parameters to memory, the Learn LED will
not remain on continuously but it will just stop
blinking. In this case Matrix 400™ emits a long low
pitched beep.

Exit the Setup function by pressing the X-PRESS™
push button once.

READY
green
GOOD
TRIGGER
yellow 1"'%@!@
com
yellow ———{IIHEHD
STATUS
w —@) (A

Figure 10 — X-PRESS™ Interface:
Setup Function

READY
GOOD
TRIGGER
yellow 1‘.'%#!@
com
yellow @.IH%»
STATUS
o —@) (A

Figure 11 — X-PRESS™ Interface:
Learn Function
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STEP 6 — X-PRESS™ CONFIGURATION

Once Matrix 400™ has calibrated image density, you can configure it for optimal code
reading relative to your application. This configuration can be performed either through the X-
PRESS™ Interface or the VisiSet™ configuration program.

Locate
READY

1. Enter the Focus function by pressing and holding
the X-PRESS™ push button until the Focus LED ~ 9"¢€"
is on. GOOD

2. Release the button to enter the Focus function. ~ 9"€M
The Blue Diamonds™ turn on. TRIGGER

3. Select a code from your application. Position yellow
the code at the center of the FOV (equidistant from com
the Blue Diamonds ™). yellow

4. Exit the Focus function by pressing the X- STATUS
PRESS™ push button once. The Blue red —@ @
Diamonds™ turn off.

Figure 12 — X-PRESS™ Interface:
Locate Function

Setup

5. Enter the Setup function by pressing and holding
the X-PRESS™ push button until the Setup LED is

on.
READY
6. Release the button to enter the Setup function.
The Setup LED will blink until the procedure is o oo
completed. GooD
The Setup procedure ends when the Image green
Acquisition parameters are successfully saved in TRIGGER
the reader memory, the Setup LED will remain on  Yyellow
continuously and Matrix 400™ emits 3 high pitched com
If the calibration cannot be reached after a timeout STATUS
of about 5 (five) seconds Matrix 400™ will exit g  — (@ ) @

without saving the parameters to memory, the
Setup LED will not remain on continuously but it will
just stop blinking. In this case Matrix 400™ emits a
long low pitched beep.

7. Exit the Setup function by pressing the X-

PRESS™ push button once.

Figure 13 — X-PRESS™ Interface:
Setup Function
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Learn

8. Enter the Learn function by pressing and holding
the X-PRESS™ push button until the Learn LED is

on.

9. Release the button to enter the Learn function. READY
The Learn LED will blink until the procedure is  green
completed. GOOD
The Learn procedure ends when the Image  green

Processing and Decoding parameters are
successfully saved in the reader memory, the

TRIGGER

Learn LED will remain on continuously, the Green yellow

Spot is activated and Matrix 400™ emits 3 high COM

pitched beeps. yellow

If the calibration cannot be reached after a timeout STATUS

of about 3 (three) minutes Matrix 400™ will exit  red —@ @
without saving the parameters to memory, the

Learn LED will not remain on continuously but it will Figure 14 — X-PRESS™ Interface:
just stop blinking. In this case Matrix 400™ emits a Learn Function

long low pitched beep.

10. Exit the Setup function by pressing the X-
PRESS™ push button once.

If you have used this procedure to configure Matrix 400™ go to step 9.

10
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STEP 7 — INSTALLING VISISET™ CONFIGURATION PROGRAM

VisiSet™ is a Datalogic reader configuration tool providing several important advantages:

e Setup Wizard for rapid configuration and new users;

o Defined configuration directly stored in the reader;

¢ Communication protocol independent from the physical interface allowing to consider the
reader as a remote object to be configured and monitored.

To install VisiSet™, turn on the PC that will be used for the configuration, running
Windows 98, 2000/NT, XP or Vista, then insert the VisiSet™ CD-ROM, wait for the CD to
autorun and follow the installation procedure.

This configuration procedure assumes a laptop computer, running VisiSet™, is connected to
the reader's auxiliary port.

After installing and running the VisiSet™ software program the following window:

File Edit Conmect Disconmect Device Options Tools Help

Connection: none. Reader Status: NOT COMMECTED Log : OFF

Figure 15 - VisiSet™ Opening Window

11
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Set the communication parameters from the "Options" menu. Then select "Connect", the
following window appears:

MAIH MERU

M. Setup Wizard

F. Calibration Tool

V. Symbol Verification

A. Run Mode

B. Capture Image

C. Decode Last Iimage

D. View Last Image

E. Download Last Image

H. Upload Bitmap Image

File Edit Connect Disconnect Device Options Tools Help

Device: Matrix 400
Model: 600-010
Communication Port: Auxiliary

Standard Application Program for Matrix Family Rel. 5.40
Standard Application Program for Ethernet Board Rel. 3.03

MACHUM: DO007BE0D4339

DHCP disabled.
IPF Address: 172.16.11.12
Subnet Mask: 255.255.0.0
Gateway: 172.16.0.254
DHS1: 172.16.0.21
DHS2: 0.0.0.0

0. Image Buffer
3. Button Function Menu

Connection: COSI00820 on COMI ak 115200,M,8,1

Reader Status: OFF LIME MODE

Log : OFF

Figure 16 - VisiSet™ Main Window After Connection

STEP 8 — CONFIGURATION USING SETUP WIZARD

The Setup Wizard option is advised for rapid configuration or for new users. It allows reader

configuration in a few easy steps.

1. Select the Setup Wizard button from the Main menu.

EB Setup Wizard
TopLeft

E]|E”z| a5 Setup Wizard

Image Acquisition Information
Acquisition Setting

Decoding Results
Symbalogy:
Code Data:
Code Center

Image Lighting Quality

Capture Image
Battarn Right g

Selected Code:

=

To/Rx,

L] Close

1. Pasitioning Send Defaults
Calibration Mode

2. Calibration

3. Code Setting

__ssae |

Setup Result

& Change Exposure Time And Gain (Static Mode]
" Change Gain Only

Fine Focusing
Code Setting Mode

* Add New Symbology
" Replace Current Symbologies

Saving Options
" Permanent Memony

 Temporary Memary

12
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2. Remove the lens cover in order to focus the reader and loosen the two Locking Knobs on
the lens.

Adjust the Focus ring to the "Far position" and the Diaphragm ring to the "F4"? number
setting which is the preferred setting for installation.

Place the Grade A Barcode Test Chart in front of the reader at the correct reading
distance (see step 3 and the Optical Accessory Selection table in the par. 7.1).

3. Press the "Positioning" button. The reader continuously acquires images and gives visual
feedback in the view image window. Select the largest code from the chart that
completely fits into the view image window. Move the reader (or code) to center it. The
code must be aligned across the X-axis reference line at the center of the FOV. See
figure below.

Press the Positioning button again to stop positioning.

& Setup Wizard g|§||g| H Setup Wizard B\EHX\
TopLelt —

[l AE= e
Lt

0.18 mm
!

Calibration Mods
% Change Exposure Time And Gain (Static Mode]

I
| I i " Change Gain Only
I '“IWN m.._._.._.._
0.20 mm
Cade Seting Mode

|
|
|
‘ | | @ Add New Symbolagy
‘ i " Replace Current Symbalogies
| g
Buattom Right

Saving Options

Image Acquisition Information W oo
Acquisition Setting 1 Self Turing: Disabled & Temporary Memary
Exposure Time (1 Ous): 5
Eidiie B0 Setup Result
Decoding Results
Symbology: Selected Cade =
Code Data:
Code Center:
Image Lighting Quality
THARR
i) Close

2 For far reading distances, the Diaphragm ring can be set to values between F2 and F4 to increase image lighting.

13
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4. Select a Calibration Mode choice and press the "Calibrate" button. The reader flashes
once acquiring the image and auto determines the best exposure and gain settings. If the
code symbology is enabled by default, the code will also be decoded.

EB Setup Wizard
Top Left

E”E”z| &£ Setup Wizard

0.1# mm
|
i
i
|

~~~~~~~~ e

0.20 mm
|
!
|

[y

Image Acquisition Information

Capture Image
igw Image
Download Image
Eottom Right

Exposure Index

Underexposed oK Overexposed

TR,

|

Lighting Index:

Close

Positioning

Send Defaults

1
4
L

2. Calibration

Calibration Mode
* Change Expasure Time And Gain [Static Maode)
" Change Gain Only

Acquisition Setting: 1 Self Tuning: Enabled G TRk

Exposure Time [+10us]: 26 Status: Completed

Eeili 479 Setup Result

Decoding Results

. fi=|

Symbalogy: Selzcted Code: h -

Code Data: Calibration procedure in progress ...

Code Center:
Calibration procedure completed using Image Acequisition
Setting #1.

= New Exposure Time (x10us): 26
I Light ity
mage Lighting Glualir Hew Gain H

4. Save

s —

5 Fine Focusing

Code Sefting Mode
¢ Add New Symbology
" Replace Current Symbalogies

3. Code Setting

Saving Options
" Permarent Memary

5. Press the "Fine Focusing" button to activate the Fine Focusing Tool.
The reader continuously acquires images and gives visual feedback on the focusing

quality in the Focusing Tool window.

@ Focusing Tool

(5]
Focus information
Current Focus Quality:
Maximum Grey Level (Light)
Minirurn Grey Level (Dark):

Stop Image Acquisition
& Disablad
" Enabled

‘wihite (255]

=

Black (0]

LEX

Cursor Position: 600

Line Scan Yiewer

’“le Zonm

Close

Magimum Session Yalue

Grey Yalue: 102

i3l Panoramic View

Rotate the Focusing ring on the lens. The Current Focus Quality Bar (green) together

with the vertical optimal focus line (green) increase together until the optimal focus is
reached; the vertical optimal focus line stops.

14
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Continue rotating the Focusing ring on the lens a little farther; the Current Focus
Quality Bar decreases (red) see below.

il

[T

Focus informati

Current Focus Quality:

‘wihite (255]

MM“.MFWWW
]

Black (0]

I

on

Maximum Grey Level (Light) 255

Minirurn Grey Level (Dark): 1 Cursor Position: 800

Stop Image Acquisition Line Scan Wiswer

& Disablad -

* Enabled iz ] zoom
Close

Magimum Session Yalue

GreyYValue: 27

i3l Panoramic View

@ Focusing Tool g@

TR

Rotate the Focusing ring in the opposite direction. The Current Focus Quality Bar (green)
increases towards the vertical optimal focus line (green) until the optimal focus is
reached; the Current Focus Quality Bar touches the vertical optimal focus line

(indicating the best focus).

Focus information

Current Focus Quality:

I

Maxirum Grey Level (Light) 255

binimum Grey Lewvel (Dark): 12 Cursor Position: 800
Stop Image Acquisition Line Scan Wiswer

& Disahled

" Enabled

’hTiI Zoom M Panorarmic view

Close

Maximum Session Value

Grey Walue: 23

White (255)
Wlm"wwm T I!‘IlW"FWWM
T ] i
Black [0)

Tighten the Locking Knobs on the lens and press the "Close" button to return to the

Setup Wizard.

15
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6. Select a Code Setting Mode choice and press the "Code Setting" button.
Using the Grade A Barcode Test Chart, this step performs image density calibration in
order for Matrix 400™ to function correctly and to the fullest extent of its capabilities.

The Setup Result section of the Setup Wizard window shows the code type results and
the image density calibration settings.

EE Setup Wizard

EE Setup Wizard

Positioning Send Defaults
Calibration Mode

2. Calibration * Change Expasure Time And Gain [Static Maode)
" Change Gain Only

Fine Focusing

Code Sefting Mode
¢ Add New Symbology

Top Left

1= 1)

Capture Image ]

1
6 3. Code Setting
L

padiinace | " Fieplace Currert Symboloaies
Download Image

i : Bottom Right Saving Options
Image Acquisiion Information o o
Acquisition Setting: 1 Self Tuning: Dizabled G TRk
Exposure Time [+10us]: 26
Eeili 479 Setup Result
Decoding Riesults &
Syrbaloay: Code 128 Selected Cade ’rﬂ Code Setting procedure in DrOgress ......
Code Data: 020 mm Code Serring procedurs completed: 3 code(s) found.
Code Center: [¥.¥]=(807.592] Code Symbologies:

i 1. Code 128
Code Orientation: 1} > Code 128
Image Lighting Gualiy SeEiis A

Processing Mode 1 Standard
Exposure Index Lighting Inde::
Underexposed oK. Overexposed Image Density calibration procedure completed:
Image Density (PPI] = 464
Tos/ R Field Of View 88 mm x 66 mm
v

] Close

7. Place the application specific code in front of the reader at the same reading distance
and repeat steps 3, 4, and 6.

@ Setup Wizard

E Setup Wizard

16

TopLeft

Image Acquisition Informatiorn

Acquisition 5 etting: 1
Exposuire Time [x10usk =
Gain 403

Decoding Resulty

Symbology: Data Matriz ECC 200
Code Data: Datalogic 20 Code Reader
Code Center: [*q.¥']1=1799.598)
Code Drientation [t}
Image Lighting Quality
Exposure Index:
Underesposed gy Dveresposed

4

Capture Image
Wiew Image 6'

as10i

3

Paositianing Send Defaults
Calibration Mode
2 Calibration (& Change Exposure Time And Gain [Static Mods)

" Change Gain Only

H

Focusing

Code Setting Mode
&+ Add Mew Symbology
" Replace Current Symbologies

Finej

-

3. Code Sefting |

Download Image
Bottarn Right

Self Tuning Disabled

Saving Options
" Permanent Memary

4. Save

& Temporary Memory

Selected Code:

=

Quality Index:

Lighting Indsx:

TR

[

Close

Setup Result

Setup Result

~
Code Setting procedure in progress ...
Code Setting procedure coupleted: 1 code(s) foumd.

Code Symbologies:

1. Data Matrix ECC 200

FProcessing Mode 1 Srandard

Rectangular Formats : Disabled

Code Color i Black

Image Mirroring : Disabled

Code Contrast [2D) : Grandard

Decoding Method : Standard

~
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8. Select a Saving Options choice and press the "Save" button.

m Setup Wizard

Positioning Send Defaults
Calibration Mode

2 Calibration (% Change Exposure Time And Gain [Static Made)
" Change Gain Only

Fine Focusing

Code Setting Mode

3. Code Seting (+ Add New Symbology

" Replace Current Symbologies

Saving Optiong

% Pemnanent Mermary ‘_

" Temporary Memary

etup Result
. F ~
Code Setting procedure completed: 1 code(s) found.
Code Symbologies:
1. Data Matrix ECC 200
Processing Mode : standard
Rectangular Formats : Dizabled
Code Color : Black
Inage Mirroring : Dizabled
Code Contrast [2D) : Standard
Decoding Method 1 Gtandard
Checking configurarion. ..ok
Configuration saved in Permanent memory!
v

9. Close the Setup Wizard.

NOTE

If your application has been configured using the VisiSet™ Setup Wizard, your
reader is ready. If necessary you can use VisiSet™ for advanced reader
configuration.

17
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STEP 9 - TEST MODE

Use a code suitable to your application to test the reading performance of the system.

1. Enter the Test function by pressing and holding the X-PRESS™ push button until the
Test LED is on.

2. Release the button to enter the Test function.
Once entered, the Bar Graph on the five LEDs is activated and if the reader starts

reading codes the Bar-Graph shows the Good Read Rate. In case of no read condition,
only the STATUS LED is on and blinks.

green LEARN

Q
ﬁgiﬁ
5|78

green SETUP
TRIGGER

yellow O FOCUS
com

yellow
STATUS

o —@) (A

Figure 17 — X-PRESS™ Interface: Test Function

3. To exit the Test, press the X-PRESS™ push button once.

@ By default, the Test exits automatically after three minutes.
NOTE

The Bar Graph has the following meaning:

>95% LEARN

>75% SETUP

| [n]

ﬁ%ﬁgﬁﬁ
) o E
3

> 60% FoCus
coM

> 40%
STATUS

220 —(@ )
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ADVANCED READER CONFIGURATION

For further details on advanced product configuration, refer to the VisiSet™ Help On-Line.

The following are alternative or advanced reader configuration methods:

Advanced Configuration Using VisiSet™

Advanced configuration can be performed through the VisiSet™ program by selecting
Device> Get Configuration From Temporary Memory to open the Parameter Setup window in
off-line mode. Advanced configuration is addressed to expert users being able to complete a
detailed reader configuration. The desired parameters can be defined in the various folders
of the Parameter Setup window and then sent to the reader memory (either Temporary or
Permanent):

DECEN File Device Mode

M. Setup Wizard

Get | Send| Send Delaulls| Permanent ‘ Interactive

F. Calibration Tool

V. Symbol Vrification i:x::ij 2D Codes ] 10 Codes } Postal Codes } Image: Processing ] Mizcellaneaus }
. S DoioColection | MalchCode | SymbolVerfication | Commurication |

A.Run Mode: S Fcading SystemLayout | Ethemet | Fieldbus | Display | Diagostics

bl OperaiingModes | Caibration | Dighal /0 | LEDsAndKeypad
B. Capture Image Su

B OPERATING MODE
C.Decode Last Iinage Y Operating Mode Fhase Mode
DH

D. View Last Image Reading Phase ON Ext. Trig. Leading Edge
E. Download Last Image Acquisition Trigger Continuous

Reading Phase OFF Ext. Trig. Trailing Edge
R e Image Aeqisition Bufter Size 2
0. Image Buffer ACOUISITION TRIGGER DELAY 1

Disabled

3. Button Function Menu Slois

[Connection; COBI00E20 on COML &k 115200,1,6,1 Reader Status; OFF LINE MODE Log : OFF

Figure 18 - VisiSet™ Parameter Setup Window

Host Mode Programming

The reader can also be configured from a host computer using the Host Mode programming
procedure, by commands via the serial interface. See the Host Mode Programming file on
the CD-ROM.

Alternative Layouts

If you need to install an Ethernet network, ID-NET™ network, Fieldbus network, Pass-
Through network, Multiplexer network or an RS232 Master/Slave refer to the Matrix 400™
Reference Manual.

Code Quality Verification

Matrix 400™ can be used as a Code Quality Verifier according to the ISO/IEC 15415,
ISO/IEC 15416, AS9132, and AIM DPM Standards. For more details see the Matrix 400™
Code Quality Verifier Solution manual on the CD-ROM.
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2 INTRODUCTION

2.1 PRODUCT DESCRIPTION

Matrix 400™ is a Datalogic industrial compact 2D imager designed and produced to be a
high performance affordable solution for both linear and two-dimensional code reading
applications.

Matrix 400™ uses imaging technology and provides complete reading system functions by
integrating image capturing, decoding and communicating in a single compact and versatile
product.

Matrix 400™ sets a new standard in 2D imager technology offering high performance with
improved reading flexibility thanks to its intrinsic modularity.

Matrix 400™ features excellent reading and verifying performance thanks to 1.3 and 2.0
Mega pixel sensors and smart proprietary decoding libraries.

The modular combination of Mega pixels sensors, powerful lighting and adjustable C-Mount
lenses provide high flexibility in covering application with various requirements.

Innovative X-PRESS™ interface, combined with Blue Diamonds™ aiming and focusing
system and a Good Read Spot, enhance the ease of setup and use.

Rugged construction, IP67 protection and max 50°C operative temperature make the Matrix
400™ the ideal product for industrial applications.

Matrix 400™ has been developed for use in numerous industries like:

Automotive
= DPM (Direct Part Marked) Reading and Verification
= Tires Sorting

Electronics
= Large PCB Board Tracking
= Electronics Product Tracking

Distribution & Retail Industry

= Presentation Scanner

= Small Objects Tracking & Sorting
=  Warehouse applications

Medical & Pharmaceutical

= Medical Devices Traceability

=  Pharmaceutical and Medicine Manufacturing
= Chemical & Biomedical Analysis

Food & Beverage
=  Work in Progress Traceability
= Code Quality Control

This technology intrinsically provides omni-directional reading.

20
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Standard Application Program

A Standard Application Program is factory-loaded onto Matrix 400™. This program controls
code reading, data formatting, serial port and Ethernet interfacing, and many other operating
and control parameters. It is completely user configurable from a Laptop or PC using the
dedicated configuration software program VisiSet™, provided on CD-ROM with the reader.

There are different programmable operating modes to suit various code reading system
requirements.

Quick, automatic focus, positioning, calibration and code setting of the imager can be
accomplished using the X-PRESS™ button and LEDs on top of the reader without the
necessity of a PC.

The previous functions can also be performed through VisiSet™ through the Setup Wizard.
This tool includes visual feedback from the reader.

VisiSet™ provides a Calibration Tool to verify the exact positioning of the reader and to
maximize its reading performance.

Statistics on the reading performance can also be visualized through a dedicated window in
VisiSet™.

Symbol Verification can be performed through VisiSet™ when the reader has been installed
and setup as a Verifier station. For details see the Matrix Code Quality Verifier Solution
manual.

Programmability

If your requirements are not met by the Standard Application Program, Custom Application
Programs can be requested at your local Datalogic distributor.

Some of the main features of this reader are given below:

Excellent Performance

o 1.3 MPixels (SXGA) & 2.0 MPixels (UXGA) models

¢ Adjustable focus through C-Mount lenses

o Powerful Internal Lighting Systems

¢ Outstanding decoding capability on 1D, 2D, Stacked, Postal symbologies

¢ Excellent performance on DPM applications

¢ Omni-directional reading

e Frame Rate up to 27 frames/sec for SXGA models and 15 frame/sec for UXGA models
¢ Region Of Interest Windowing for higher frame rate

e Up to 100 readable codes in a single frame
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Ease of Setup

¢ Quick installation without PC by using X-PRESS™ interface for easy and intuitive setup
¢ Blue Diamonds™ aiming and focusing system

¢ Automatic Imager calibration and Code Settings

e Calibration Tool to verify exact code positioning in the Field of View and to maximize the
reading performance

¢ Windows-based VisiSet™ software to configure the reader parameters via PC serial or
Ethernet interface

o User-defined database of Image Acquisition Settings (parameter sets)
e Smart Fast Bracket

Ease of Use

o X-PRESS™ interface LEDs provide operational and performance feedback
¢ Green Spot and beeper for immediate Good Read feedback

¢ Different operating modes to suit various application requirements

e Multi Image Acquisition Settings for higher reader flexibility

¢ Run Time Self-Tuning for extreme reader flexibility

¢ Image saving and storage with buffering capability

¢ Diagnostic software tools

Flexible Solution
e Modular design
¢ Adjustable C-Mount lenses

o Complete set of Accessories like external lighting systems, light filters, mounting brackets,
connection boxes, cables and photocells

o Ethernet Connectivity with TCP/IP socket for reader parameter configuration, data and
image transfer, HTTP server, FTP and mail client, etc.

¢ 3 serial communication interfaces (Main, Auxiliary, ID-NET™)

e General purpose optocoupled 1/Os

Versatility
¢ Excellent reading performance on Direct Part Marked (DPM) symbols

o Code Quality Verification according to ISO/IEC 16022, ISO/IEC 18004, ISO/IEC 15415,
ISO/IEC 15416 and AS9132 and AIM DPM standards.

¢ Match Code option with a user-defined match code database
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Industrial Strength

e Industrial compact 2D reader

¢ Rugged full metal construction

e Sealed circular connectors

e |P67 protection class

e 50 °C max operating temperature

¢ Supply voltage ranges from 10 to 30 Vdc

The reader is particularly suitable for industrial environments where protection against harsh
external conditions is required.

The reader is contained in an aluminum housing; with its internal illuminator, C-Mount lens
and protective cover, the mechanical dimensions are 123 x 60.5 x 87 mm and it weighs
about 482 g.

Electrical connection of Power, Host interfaces and I/O signals is provided through an M16
(IP67) 19-pin connector (Figure A, 9). A standard M12 D-Coded (IP67) Ethernet connector is
present on Matrix 400 XXX-X1X models (Figure A, 10).
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2.2 INDICATORS AND KEYPAD BUTTON

READY
GOOD

TRIGGER

interface

}:‘ press

oM

—(0D

STATUS / /~,

Figure 19 - Indicators

The following LED indicators are located on the reader:

NET yellow LED indicates connection to the on-board Ethernet network (for Ethernet
models) (Figure 19, 1)
PWR blue LED indicates that the reader is connected to the power supply (Figure 19, 2)

In normal operating mode the colors and meaning of the five LEDs are illustrated in the

following table:

READY green LED indicates that the reader is ready to operate (Figure 19, 3)

GOOD green LED confirms successful reading (Figure 19, 4)

TRIGGER |yellow LED indicates the status of the reading phase (Figure 19, 5)

COM yellow LED indicates active communication on the main serial port * (Figure 19, 6)
STATUS red LED indicates a NO READ result (Figure 19, 7)

* When connected to a Fieldbus network through the CBX500, the COM LED is always active, even in the
absence of data transmission, because of polling activity on the Fieldbus network.

During the reader startup (reset or restart phase), these five LEDs blink for one second.

In X-PRESS™ Configuration mode the colors and meaning of these five LEDs are described

in par. 2.4.

The keypad button (Figure 19, 8), is software programmable. By default it starts the X-
PRESS™ interface for quick installation without using a PC (see chp. 1).
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2.3 ID-NET™

The ID-NET™ network is a built-in high-speed interface dedicated ™
for high-speed reader interconnection. ID-NET™ is in addition to
the Main and Auxiliary serial interfaces. ID NET

The following network configurations are available:

= |D-NET™ M/S Synchronized: Single station — multiple readers

CEX100 CEZ100

ID HET

ID-NET™ interface allows local connection of multiple readers reading different sides of the
same target. All readers share a single presence sensor and activate/deactivate

simultaneously.
At the end of each reading phase a single data message is transmitted to the host.

Thanks to ID-NET™, data communication among readers is highly efficient so that an
immediate result will be available.
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= |D-NET™ M/S Multidata: Multiple stations — single reader

9, 00,

CEZ100 CEE100 CEX100

ID HET

ID-NET™ interface allows connection of readers reading objects placed on independent
conveyors. All readers are typically located far away from each other and they use a
dedicated presence sensor.

At the end of each reading phase, each reader transmits its own data message to the host.
Thanks to ID-NET™, data collection among readers is accomplished at a high speed without
the need of an external multiplexing device. This leads to an overall cost reduction and to a
simple system wiring.

2.3.1 How To Setup/Configure the Reader Network

A complete ID-NET™ reader network can be easily setup through VisiSet™ as follows:

Mounting & Connection

1. Mechanically mount/install all the readers (refer to par. 3.2 and 3.3).
2. Wire ID-NET™ (refer to par. 4.3 or 5.5).

3. Power up the entire system.

Configuration of Slaves

1. Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Slave reader.

Launch VisiSet™ and connect to the Slave reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Slave reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

5. Set the Slave Address according to the desired value 0-31 from the
Reading System Layout > Device Network Setting > Slave Address parameter. Each
reader must have a different Address on the ID-NET™ Network.

6. If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).
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7. Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

8. If using the CBX connection box equipped with a BM100 Backup module, perform Device
Backup at the Slave.

The Slave device is now Configured. Repeat these steps for each Slave reader in the ID-
NET™ network.

Configuration of Master

1. Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Master reader.

Launch VisiSet™ and connect to the Master reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Master reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

5. Enable the planned Slave device N from the Reading System Layout >
Expected Slave Device #N > Status parameter and, if desired, set the related
identification string from the Expected Slave Device #N > Device Description parameter.
Repeat this step for all planned Slave devices.

6. If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

7. Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

8. If using the CBX connection box equipped with a BM100 Backup module, perform Device
Backup at the Master.

9. From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices
within the ID-NET™ network.

FH MD-NET Status Window

Stop Devices Metwork Searching |

Slave Address |Hequested Status|Eurrent Statug |Device Description |Serial MNuraber | ~

1 EEnabIed Present I atriwd 00 COPHOE16

2 Enabled Present F atrix4 00 COFHOTE13

Exit

The reader network is ready.
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2.4 X-PRESS™ HUMAN MACHINE INTERFACE

X-PRESS™ is the intuitive Human Machine Interface designed to improve ease of
installation and maintenance.

Status information is clearly presented by means of the five colored LEDs,
whereas the single push button gives immediate access to the following
relevant functions:

READY

GOOD

e Learn to self-detect and auto-configure for reading unknown codes =
IGGER

press

‘ interface

o Setup to perform Exposure Time and Gain calibration.
COM

e Focus/Locate to turn on the Blue Diamonds™ to aid focusing and [ga@rT)
positioning.

v
-

)

e Test with bar graph visualization to check static reading performance

241 X-PRESS™ Functions

Quick access to the following functions is provided by READY
an easy procedure using the push button: green
1 — Press the button (the Status LED will give a GOoD

visual feedback). green
2 — Hold the button until the specific function LED is TRIGGER

on (Test, Focus, Setup or Learn). yellow QO rocus
3 — Release the button to enter the specific function. com

yellow O rest

Once button is pressed, the cycle of LEDs activation is as follows:

w —0D (A
READY

Q
@
@
>
a
>
a
2

READY READY
GOOD GOOD

green green green SETUP,
TRIGGER TRIGGER
yellow O rocus yellow O rocus yellow @ rocus
CcOoM COoM CcoM
yellow yellow yellow
STATUS STATUS STATUS
red —@ @ red —@ @ red —@ @
> > >
Release button Release button Release button
to Exit to enter Test Mode to enter Focus/Locate Mode
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READY

READY READY
GOOD 00D GOOD

G

green SETUP, green —m green SETUP,

I
ﬁ

TRIGGER TRIGGER TRIGGER
yellow @ rocus yellow @ rocus yellow O rocus
com com com
yellow yellow yellow
STATUS STATUS STATUS
red —@ @ red —@ @ red —@ @
> > => (cycle)
Release button Release button Release button
to enter Setup Mode to enter Learn Mode to Exit

Test Mode (Function 1)

Once entered, the Bar Graph on the five LEDs is activated and if the imager starts reading
codes the Bar-Graph shows the Good Read Rate. In case of a NO READ condition, only the
Status LED is on and blinks.

The Bar Graph has the following meaning:

READY
295%
GOOD

> 75% SETUP
TRIGGER
com

> 40% Qrest
STATUS

>20% —(@ )

To exit the Test Mode, press the X-PRESS™ push button once.

@ By default, the Test exits automatically after three minutes.
NOTE

Focus/Locate (Function 2)

This function causes the Blue Diamonds™ to turn on. The Blue Diamonds™ can be used to
focus the lens at the desired reading distance and since they are centered on the FOV they
can also be used to position the imager on the code. The Focus LED blinks to indicate this
state.

To exit the Focus/Locate Mode, press the X-PRESS™ push button once. The Blue
Diamonds™ turn off.
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Setup (Function 3)

Once entered, the imager automatically performs Image Acquisition parameter calibration for
the specific code presented to it.

The Setup LED will blink until the procedure is completed.

The Setup procedure ends when the Image Acquisition parameters are successfully saved in
the reader memory, the Setup LED will remain on continuously and Matrix 400™ emits 3 high
pitched beeps.

If the calibration cannot be reached after a timeout of about 5 (five) seconds Matrix 400™ will
exit without saving the parameters to memory, the Setup LED will not remain on continuously
but it will just stop blinking. In this case Matrix 400™ emits a long low pitched beep.

Learn (Function 4)

Once entered, the imager starts a procedure to automatically detect and recognize codes
which are presented to it.

The Learn LED will blink until the procedure is completed.

The Learn procedure ends when the Image Processing and Decoding parameters are
successfully saved in the reader memory, the Learn LED will remain on continuously and
Matrix 400™ emits 3 high pitched beeps.

If the calibration cannot be reached after a timeout of about 3 (three) minutes, Matrix 400™ will
exit without saving the parameters to memory, the Learn LED will not remain on continuously
but it will just stop blinking. In this case Matrix 400™ emits a long low pitched beep.

2.5 MODEL DESCRIPTION

The Matrix 400™ reader is available in different versions according to the following
characteristics:

I I
MATRIX 400 XXX-0X0

Sensor Size llluminators Lens Interface
4 = SXGA (1280x1024) 0 = BS (Base, No llluminator) 0 = C-Mount (No Lens) 0 = Serial
6 = UXGA (1600x1200) 1 = Ethernet
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2.6 ACCESSORIES

The following accessories can be used with the Matrix 400™ reader.

Accessory Description Order No.
Lenses

LNS-1006 6 mm C-Mount Lens 93ACC1793
LNS-1109 9 mm C-Mount Lens 93ACC1794
LNS-1112 12.5 mm C-Mount Lens 93ACC1795
LNS-1116 16 mm C-Mount Lens 93ACC1796
LNS-1125 25 mm C-Mount Lens 93ACC1797
LNS-1135 35 mm C-Mount Lens 93ACC1798
LNS-1150 50 mm C-Mount Lens 93ACC1799
Internal llluminators

LT-001 Internal llluminator Red Narrow Angle 93A401019
LT-002 Internal llluminator Red Wide Angle 93A401020
LT-003 Internal llluminator White Narrow Angle 93A401021
LT-004 Internal llluminator White Wide Angle 93A401022
LT-006 Internal llluminator Red Super Narrow Angle 93A401024
External llluminators

LT-100 Cone Lighting System 93A401003
LT-200 Spot Lighting System 93A401004
LT-210 Mini-Spot Lighting System 93A401012
LT-300 Ring Lighting System 93A401008
LT-314 45° Dark Field Ring Lighting System 93A401013
LT-316 60° Dark Field Ring Lighting System 93A401014
LT-410 Coaxial Lighting System 93A401015
LT-510 Mini-Dome Lighting System 93A401016
LT-511 Dome Lighting System 93A401017
LT-630 Four Bar Lighting System 93A401018
Filters

FLT-111 IR Cut Filter (d 27 mm) 93ACC1800
FLT-112 IR Cut Filter (d 25.5 mm) 93ACC1801
FLT-121 Linear Polarizer (d 27 mm) 93ACC1802
FLT-122 Linear Polarizer (d 25.5 mm) 93ACC1803
Cables

CAB-MSO01 M16-IP67 Cable To CBX (1M) 93A051358
CAB-MS03 M16-1P67 Cable To CBX (3M) 93A051359
CAB-MS05 M16-IP67 Cable To CBX (5M) 93A051360
CAB-ETH-MO01 M12-1P67 Ethernet Cable (1M) 93A051346
CAB-ETH-MO03 M12-1P67 Ethernet Cable (3M) 93A051347
CAB-ETH-M05 M12-1P67 Ethernet Cable (5M) 93A051348
Connection Boxes

CBX100 Compact Connection Box 93A301067
CBX500 Modular Connection Box 93A301068
BM100 Backup Module for CBX100/500 93ACC1808
* BM150 Display Module for CBX500 93ACC1809
* BM300/BM310 Profibus Module STD/IP65 for CBX500 93ACC1810, 93ACC1811
* BM400 DeviceNet Module IP65 for CBX500 93ACC1814

Power Supplies

PG6002 AC/DC Power Supply Unit (US) 93ACC1718
PG6001 AC/DC Power Supply Unit (UK) 93ACC1719
PG6000 AC/DC Power Supply Unit (EU) 93ACC1720
LTC-630 Four Bar Lighting System Controller 93ACC1790
Sensors

PH-1 Photocell Kit PNP 93ACC1791
MEP- 543 Photocell Kit-NPN 93ACC1728
Brackets

USX-60 Adjustable Bracket 93ACC1729
BK-4410 Coaxial LT Bracket Matrix 400 93ACC1804
BK-4990 Generic LT Bracket Matrix 400 93ACC1805
ISO/IEC Calibration Chart Calibration Chart for Code Verifier Solution 93ACC1841

* Accessories compatible with Matrix 400™ application software 5.20 and later.
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The following table shows the correct lens/illuminator combinations to be used for Matrix
400™ imager assembly.

Lenses Internal llluminators
93ACC1793 |LNS-1006 |6 mm C-Mount Lens 93A401020 |LT-002 Red Wide Angle
(only for Matrix 400 600-0x0 models) 93A401022 [ LT-004 White Wide Angle
93ACC1794 |LNS-1109 |9 mm C-Mount Lens 93A401020 |LT-002 Red Wide Angle
93A401022 | LT-004 White Wide Angle
93ACC1795 |LNS-1112 | 12.5 mm C-Mount Lens 93A401020 |LT-002 Red Wide Angle
93A401022 | LT-004 White Wide Angle
93ACC1796 |[LNS-1116 |16 mm C-Mount Lens 93A401019 | LT-001 Red Narrow Angle
93A401021 | LT-003 White Narrow Angle
93ACC1797 |[LNS-1125 |25 mm C-Mount Lens 93A401019 | LT-001 Red Narrow Angle
93A401021 [ LT-003 White Narrow Angle
93ACC1798 |[LNS-1135 |35 mm C-Mount Lens 93A401024 | LT-006 Red Super Narrow Angle
93ACC1799 [LNS-1150 |50 mm C-Mount Lens 93A401024 | LT-006 Red Super Narrow Angle

2.7 APPLICATION EXAMPLES

Matrix 400™ is profitably used in the omnidirectional reading of 2D, stacked, linear and
postal codes for example in automated document handling and mail processing systems
(see Figure 20).

Figure 20 - Address Coded in Datamatrix Symbology for Automated Mail Processing

The Matrix 400™ high resolution image sensors allow the reading of many small codes in a
single image (see 96 vial application in Figure 21).

Figure 21 - 96-Vial Rack
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Matrix 400™ assures the reading of deformed and / or overprinted codes, even though
damaged or printed on high reflective surfaces (see Figures 22, 23, 24).

Figure 22 - Unidose Flow-Pack with PDF417 Code

Figure 23 - Overprinted Barcode Readable by Matrix 400™ also Through the Envelope Window Film

= |

Figure 24 - Barcode Printed on Curved Surface Readable by Matrix 400™ in spite of Image Optical
Distortion

Matrix 400™ is also very powerful in reading low-contrast direct part marked codes (see
Figures 25, 26, 27, 28 and 29).

Figure 25 - Dot Matrix Code Directly Marked on Metal Surface by Using Dot Peening Technology
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Figure 27 - Directly Marked Dot Matrix Code Characterized by Outstanding Separation Distance between

34

Adjacent Code Elements
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Figure 28 - DataMatrix Code Directly Marked on PCB Surface by Using Laser Etching Technology

Figure 29 - Dot Matrix Code Directly Marked on PCB Copper Pad by Using Ink-Jet Technology
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2.8 EXTERNAL LIGHTING SYSTEMS

In some direct part marking applications best reading results are obtained by using an
external lighting system. A series of accessory illuminators are available which cover a
variety of applications.

The LT-100 Cone Lighting System provides a circular symmetrical light source designed for
the following applications:

e with uneven or noisy background surfaces

e where dot peening or laser etching codes are directly marked onto metal surfaces or
PCBs and need to be highlighted

¢ in the presence of highly reflective surfaces (metal, glass, etc.) causing direct reflections

Figure 30 - LT-100 Cone Lighting System

The LT-200 Spot Lighting System provides a high intensity light source designed for the
following applications:

e with uneven, noisy and scratched surfaces

e where dot peening or laser etching codes are directly marked onto metal surfaces or
PCBs and need to be highlighted. Here the use of more than one Spot Light can remove
any shadowing effect.

¢ in the presence of highly reflective surfaces (metal, glass, etc.) causing direct reflections.
Low light path to surface angles strongly reduce direct reflections.

Figure 31 - LT-200 Spot Lighting System

35



o MATRIX 400™ REFERENCE MANUAL

The LT-210 Mini Spot Lighting System provides a high intensity light source designed for the
following applications:

o with uneven, noisy and scratched surfaces

e where dot peening or laser etching codes are directly marked onto metal surfaces or
PCBs and need to be highlighted. Here the use of more than one Spot Light can remove
any shadowing effect.

¢ in the presence of highly reflective surfaces (metal, glass, etc.) causing direct reflections.
Low light path to surface angles strongly reduce direct reflections.

-,
. 4

Figure 32 - LT-210 Mini Spot Lighting System

The LT-300 Ring Lighting System is designed for reading codes produced by Dot Peening or
Laser Etching on flat, reflective parts.

Figure 33 - LT-300 Ring Lighting System

The LT-314 45° Dark Field Ring Lighting System is designed for reading codes produced by
Dot Peening or Laser Etching on flat, reflective parts.

Figure 34 - LT-314 45° Dark Field Ring Lighting System
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The LT-316 60° Dark Field Ring Lighting System is designed for reading codes produced by
Dot Peening (especially by a 120° stylus) or Laser Etching on flat, reflective parts.

Figure 35 - LT-316 60° Dark Field Ring Lighting System

The LT-410 Coaxial Lighting System is an axial diffuse illuminator designed for reading
codes produced by Dot Peening or Laser Etching on flat parts having a matte, specular or
mixed surface reflectivity.

Figure 36 - LT-410 Coaxial Lighting System

The LT-510 Mini Dome Lighting System is a diffuse mini dome light designed for reading
printed label or Direct Marking codes on small parts with a curved or specular surface.

Figure 37 - LT-510 Mini Dome Lighting System
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The LT-511 Dome Lighting System is a diffuse dome light designed for reading printed label
or Direct Marking codes on parts with a curved surface.

Figure 38 - LT-511 Dome Lighting System

The LT-630 Four Bar Lighting System is designed for Code verification applications
according to ISO/IEC 15415 or ISO/IEC 15416 specifications.

Figure 39 - LT-630 Four Bar Lighting System
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3

INSTALLATION

3.1 PACKAGE CONTENTS

Verify that the Matrix 400™ reader and all the parts supplied with the equipment are present
and intact when opening the packaging; the list of parts includes:

Q

Matrix 400™ reader
Quick Reference Guide
Test Charts (2)

Matrix family CD-ROM

Mounting Kit

¢ Mounting Screws (4 + 3)
o Washers (2)

¢ Mounting Brackets (2)

Figure 40 - Package Contents
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3.2 MECHANICAL DIMENSIONS

Matrix 400™ can be installed to operate in different positions. The twelve screw holes (M4 x
5) on the body of the reader are for mechanical fixture (Figure 41).

The diagram below gives the overall dimensions of the reader and may be used for its
installation.

Refer to par. 3.3 for various mounting solutions and correct positioning and par. 7.2 for FOV
vs. Reading Distance considerations.

|
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Figure 41 - Overall Dimensions
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3.3 MOUNTING AND POSITIONING MATRIX 400™

Using the Matrix 400™ mounting brackets you can obtain rotation on the various axes of the
reader as shown in the diagram below:

Figure 45 —Positioning with Mounting Bracket (Front)
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Matrix 400™ is able to decode code labels at a variety of angles, however significant angular
distortion may degrade reading performance.

When mounting Matrix 400™, take into consideration these ideal label position angles: Pitch
or Skew 10° to 20° and Tilt 0°.

Note: Since Matrix 400™ is omni-directional on the code plane, the Pitch and Skew angles
have the same significance with respect to the code plane. However in some advanced code
reading applications performance can be improved by modifying the Skew angle.

Follow the suggestions below for the best orientation:

The Pitch and Skew angles are represented by the values P and S in Figure 46 and in Figure
47. Position the reader in order to avoid the direct reflection of the light emitted by the Matrix
400™ reader; it is advised to assure at least 10° for one of these angles. In some cases, such
as low contrast or low illumination, it can be useful to use a Pitch or Skew angle = 0°.

P
iy L]
s
Figure 46 - Pitch angle Figure 47 - Skew angle

The Tilt angle is represented by the value T in Figure 48. Matrix 400™ can read labels with
any tilt angle.

See par. 7.2 for FOV vs. Reading Distance considerations.
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4 CBXELECTRICAL CONNECTIONS

All Matrix 400™ models can be connected to a CBX connection box through one of the
available CAB-MSxx accessory cables. These accessory cables terminate in a 19-pin
connector on the Matrix 400™ side and in a 25-pin male D-sub connector on the CBX side.

We recommend making system connections through one of the CBX connection boxes since
they offer the advantages of easy connection, easy device replacement and filtered
reference signals.

@ If you require direct wiring to the reader the details of the connector pins and
relative connections are indicated in Chaper 5.
NOTE

The table below gives the pinout of the CBX100/500 terminal block connectors. Use this
pinout when the Matrix 400™ reader is connected by means of the CBX100/500:

CBX100/500 Terminal Block Connectors

Input Power
Vdc Power Supply Input Voltage +
GND Power Supply Input Voltage -
Earth Protection Earth Ground
Inputs
+V Power Source — External Trigger
1A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference — External Trigger
+V Power Source — Inputs
I2A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference — Inputs
Outputs
+V Power Source - Outputs
-V Power Reference - Outputs
o1+ Output 1 +
O1- Output 1 -
02+ Output 2 +
02- Output 2 -
Auxiliary Interface
X Auxiliary Interface TX
RX Auxiliary Interface RX
SGND Auxiliary Interface Reference
ID-NET™
REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -
Shield Network Cable Shield
Main Interface
RS485 RS485
RS232 Full-Duplex Half-Duplex
X TX+ RTX+
RX *RX+
RTS TX- RTX-
CTS *RX-
SGND SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.
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connection box, verify the jumper positions in the CBX as indicated in its Installation

@ To avoid electromagnetic interference when the reader is connected to a CBX
Manual.

NOTE

41 POWER SUPPLY

Power can be supplied to the reader through the CBX100/500 spring clamp terminal pins as
shown in Figure 49:

Power Supply
VGND

V+ Earth
in Ground

| | o | | o | s | s | s | e |

0000000010

vde GND|<«, [REF D+ - |8 [seno Tx RTs Rx cTs 1
POWER "% ID-NET % | maIN (R)TX+ (RITX- RX+ RX-

Figure 49 - Power Supply Connections
The power must be between 10 and 30 Vdc only.
It is recommended to connect the device CHASSIS to earth ground (Earth) by setting the

appropriate jumper in the CBX connection box. See the CBX Installation Manual for details.

4.2 MAIN SERIAL INTERFACE

& Do not connect to the Main Interface spring clamp terminals if using Host

Interface Modules with the CBX500.
CAUTION

The signals relative to the following serial interface types are available on the CBX spring
clamp terminal blocks.

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. The RS485 half duplex is automatically set
whenever MUX32 communication protocol is enabled. For more details refer to the
"Communication" folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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421 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins are used for RS232 interface connection:

CBX100/500 Function
X Transmit Data
RX Receive Data
RTS Request To Send
CTS Clear To Send
SGND Signal Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

USER INTERFACE
SGND RXD TXD

CTS RTS

o | | o || — |

Ol0I0I0I0I0O W
|

o[l

vdc GND|[&, |REF D+ - | [seno 7x RIS Rx cTs
POWER "% ID-NET % | MAIN (R)TX+ (RITX- RX+  RX-

READER SGND TX RX
RTS CTS

Figure 50 — RS232 Main Interface Connections Using Hardware Handshaking

The RTS and CTS signals control data transmission and synchronize the connected devices.

START END
OF OF
. TRANSMISSION TRANSMISSION
RTS
V. —/— I—//—
DATA DATA

TRANSMISSION TRANSMISSION

|
|
+V I
v — —

[
[
[
[
[
| |
| TRANSMISSION |
} | STOPPED | I
[ [ [ [
| [

ENABLED | I ENABLED

+V A |
= NN NN
-V

IDLE DISABLED IDLE

Figure 51 - RS§232 Control Signals

If the RTS/CTS handshaking protocol is enabled, the Matrix 400™ activates the RTS output
to indicate a message is to be transmitted. The receiving unit activates the CTS input to
enable the transmission.
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4.2.2 RS485 Full-Duplex Interface

The RS485 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The CBX pinout follows:

CBX100/500 Function
TX+ RS485 Transmit Data +
RX+ RS485 Receive Data +
TX- RS485 Transmit Data -
RX- RS485 Receive Data -
SGND Signal Ground

USER INTERFACE

RX485+ TX485+

TX485-

o || | o |

00100

Vdc GND (% REF ID+ ID- \%/ SGND  TX RTS RX CTS
POWER 7% ID-NET % | man RITX+ RITX- R+ Rx- |1

READER SGND TX+ RX+
TX- RX-

Ol
@l
@l

Figure 52 - RS485 Full-duplex Connections

@ For applications that do not use RX485 signals, do not leave these lines
floating but connect them to SGND as shown below.
NOTE

USER INTERFACE
RX485+

SGND M RX485-

/| =3|=3{= [ | [
vdic GND|<&, |REF 1+ - | [seno Tx RIS Rx cTs
POWER "% ID-NET % | mAIN (R)TX+ (RITX- RX+ RX-

O[l
o[l
@l

READER SGND TX+
TX-

Figure 53 - RS485 Full-duplex Connections using Only TX Signals
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4.2.3 RSA485 Half-Duplex Interface

@ This interface is provided for backward compatibility. We recommend using

the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
NOTE

The RS485 half-duplex (3 wires + shield) interface is used for polled communication
protocols.

It can be used for Multidrop connections with a Datalogic Multiplexer, (see par. 6.5) exploiting

a proprietary protocol based on polled mode called MUX32 protocol, where a master device
polls slave devices to collect data.

CBX100/500 Function
RTX+ RS485 Receive/Transmit Data +
RTX- RS485 Receive/Transmit Data -
SGND Signal Ground

USER INTERFACE
RTX485+

SGND [ RTX485-

| | — | | | s | | o | s | | | |
vdc GND|<& |REF D+ ID- [& [seno Tx RTS Rx cCTs 1
POWER % ID-NET % | mAIN (R)TX+ (RITX- RX+ RX-

Oll

>

READER SGND RTX+
RTX-

Figure 54 - RS485 Half-duplex Connections
This interface is forced by software when the protocol selected is MUX32 protocol.

In a Multiplexer layout, the Multidrop address must also be set via serial channel by the
VisiSet™ utility or by the Host Programming Mode.

Figure 55 shows a multidrop configuration with Matrix 400™ readers connected to a
Multiplexer.

& This is an example of multidrop wiring. Consult the multiplexer manual for

complete wiring instructions.
CAUTION
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Reader
#x

CBX100/500

«

RS485 HD
Termination

(up to 31)

Reader
#1

Resistor. ON {_@

Shield) L J

Max 2 m
>

CBX100/500

@ PG-6000
@GND

// ~ ~
~1 -1 1

RTX+

€
&
GaND

P

CBX100/500

Reader

#0

TX4

PG-6000 I

d

&om

@ PG-6000
GND)

MULTIDROP+

(Shield)

120 Ohm é

MULTIDROP- ®

Multiplexer

RS

MULTIDROP GNDg

PG-6000

~
V-

w 00ZL Xe|y 9jqed doipininy

RS232/RS485
HOST

Main Interface
o

Multidrop Cable SHIELD

Figure 55 - Matrix 400™ Multidrop Connection to a Multiplexer
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4.3 ID-NET™ INTERFACE
CBX100/500 Function
Shield Network Cable Shield
ID+ ID-NET™ network +
ID- ID-NET™ network -
REF Network Reference

4.3.1 ID-NET™ Cables

The following instructions are referred to Figure 57, Figure 58 and Figure 59.

The general cable type specifications are: CATS twisted pair + additional CATS twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 — IEC 62026
UL STYLE 2502 80°C 30V

Cable Shield MUST be connected to earth ground ONLY at the Master.
NEVER use ID-NET™ cable shield as common reference.

The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
For Common Power Connections use only 2 wires (ID+ and ID-).

DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

Reader's chassis may be connected to earth.

Network inside the same building.

Baudrate Table

Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps

Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.

NOTE

The default ID-NET™ baudrate is 500 kbps. Lower ID-NET™ baudrates
allow longer cable lengths. The baudrate is software configurable by
authorized Datalogic Automation personnel only.
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4.3.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the
Host.

Max ID-NET™ Response Time

240

220

P
o
-

-~
200 =t
““
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o
0
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80

Response Time (ms)
\!
\
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40

20

o 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Number of Nodes
= 500 kbps = =+ 250 kbps = sseseees 125 kbps

Figure 56 — ID-NET™ Response Time

CONDITIONS:

e |D-NET™ M/S Synchronized layout
e message length = 50 bytes per node
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Max 0.3 m
CBX100/500

Reader ID-NET™ Dt 7 4
Termination
Slave Resistor. ON

(up to 31) ’—.
Grieid

CBX100/500

Reader ID+ 4

Slave ID- ®

91qed 13N-al

Shield >

yjbua| xew 1o} a|qe) ajeipneg 0} 19)9Y ,

@ PG-6000
CBX100/500 .
Reader ID-NET™ D+ (white) )|
Termination
Master Resistor. ON {—@ (blue) ®

REF black) ®
Shield ® v

@ PG-6000
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| | e
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9
£
£

RS232/RS485 s

HOST

Figure 57 — ID-NET™ Network Connections with isolated power blocks
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Reader

CBX100/500

Slave

(up to 31)

Reader

ID-NET™

Termination %_

Resistor. ON

CBX100/500

Max 0.3 m

Slave

= _@ (white)

_@ (blue)

yjBus| xew Joj ajqe] ajeipneg 0} J9joY ,

Shield ®

Figure 58 - ID-NET™ Network Connections with Common Power Branch Network
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Reader

CBX100/500

Slave

(up to 31)

Reader

ID-NET™

Termination %_

Resistor. ON

CBX100/500

Max 0.3 m

Slave

= _@ (white)

_@ (blue)

yjBus| xew Joj ajqe] ajeipneg 0} J9joY ,

Shield ®

Figure 59 — ID-NET™ Network Connections with Common Power Star Network
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4.3.3 ID-NET™ Network Termination

The network must be properly terminated in the first and last reader of the network. This is
done by setting the ID-NET™ Termination Resistance Switch in the CBX100/500 to ON.

4.4 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication
folder of the VisiSet™ utility program.

The 9-pin female Auxiliary Interface connector inside the CBX is the preferred connector for
device configuration or communication monitoring.

5 1

00000
0000

9 6

Figure 60 - 9-pin female connector

If permanent system wiring is required, the following pins are used to connect the RS232
auxiliary interface:

CBX100/500 Function
RX Auxiliary Interface Receive Data
TX Auxiliary Interface Transmit Data
SGND Auxiliary Interface Reference

USER INTERFACE
RX TX

@l

o/®

+V -V

O1+ O1- 02+ 02-| +v 12A 2B -V | TX RX
OUTPUTS INPUT2 AUX

O

Vdc  GND REF D+ - [ |+ 1A 1B v [s 5
POWER 7% ID-NET % TRIGGER

Ol0/0l0/01010 l
!

—l

o[l
O[l
O[l
o[l
o[l
O[l
O

o[l
o[l
O[l

&

Reference

Figure 61 - RS232 Auxiliary Interface Connections

@ Do not connect the Aux Interface to the CBX spring clamp connectors and
the 9-pin connector simultaneously.

NOTE
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4.5 INPUTS

There are two optocoupled polarity insensitive inputs available on the reader: Input 1
(External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
e reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
¢ match code storage command when the Match Code option is enabled

The electrical features of both inputs are:
Vag = 30 Vdc max.
Iin = 10 mA (reader) + 12 mA (CBX) max.

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the minimum
pulse duration is = 0.5 milliseconds. This value can be increased through the software
parameter Debounce Filter, see the Digital I/O folder in the VisiSet™ Help On Line for further
details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

Polarity insensitive inputs assure full functionality even if pins A and B are
exchanged.

NOTE

The connections are indicated in the following diagrams:

CBX100/500 Function
+V Power Source - External Trigger
1A External Trigger A (polarity insensitive)
1B External Trigger B (polarity insensitive)
-V Power Reference - External Trigger

The yellow Trigger LED (Figure 19, 5) is on when the active state of the External Trigger
corresponds to ON.
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EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 400™ POWER

& Power is available directly to the Input Device, independently from the Power
Supply Switch inside the CBX.
CAUTION

PH-1 Photocell (PNP)

(brown)

(black) (blue)

| o | e | e e e —1 —1

90000 e/® Qe O
vdic GND| <&, |rer i+ - | | v 1A 1B v [senp 2‘
POWER "% ID-NET % TRIGGER AUX

Figure 62 — PH-1 External Trigger Using MATRIX 400™ Power

NPN Photocell

Power to Input
Photocell Signal
Photocell
Reference
| | | | s || o — —
vdc GND|<& [|REF D+ D- |9 | +v 1A 1B v [senp
POWER % ID-NET % TRIGGER AUX

Figure 63 - NPN External Trigger Using MATRIX 400™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

PNP Photocell

Input
Signal

Pulled down to External
Input Device Reference

—

— o | | s | | s | s | | i o | | —
vac GND|<, |REF i+ - | [ +v 1A 1B v [senp
POWER 7% ID-NET % TRIGGER aux |2

Figure 64 - PNP External Trigger Using External Power

NPN Photocell

Pulled up to External
Input Device Power

Input
Signal

—l

— s | | s | | e || s | | | | | —
vac GND|<, |REF i+ - [ [ +v 1A 1B v [senp
POWER 7% ID-NET % TRIGGER aux |2

Figure 65 - NPN External Trigger Using External Power
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CBX100/500 Function
+V Power Source - Inputs
12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V

Power Reference - Inputs

INPUT 2 CONNECTIONS USING MATRIX 400™ POWER

D

CAUTION

Power is available directly to the Input Device, independently from the Power

Supply Switch inside the CBX.

Input Device
Power to
Input Device

Input
Signal

Input Device
Reference

|| —

|| — [mm]w o] —

o[l

OO

o010

O

L ) @)

+V

Vo 01+

OUTPUTS

01- 02+ 02-

+V  12A 2B

INPUT2

Vo TX

AUX

RX

PNP Input 2 Using MATRIX 400™ Power

Input Device

Power to Input
Input Device Signal

Input Device
Reference
| | | o | | s o | — | | o |
+V -V O1+ O1- 02+ 02-] +V 12A 12B -V T RX
OUTPUTS INPUT2 AUX 3

INPUT 2 CONNECTIONS USING EXTERNAL POWER

NPN Input 2 Using MATRIX 400™ Power

Input Device
Input
Signal

Pulled down to External
Input Device Reference

| | o | s s | | o | | o

O|000O000 OO0

Y g1+ 01s- o2+ 022 ] +v 12A 2B v | X RX
UTPUT

INPUT2 ax |3 ‘

Figure 66 - PNP Input 2 Using External Power
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Input Device
Pulled up to External
Input Device Power

Input
Signal

s | o | s | s | s || | s o || — | | —

OO0 O OO0

+V -V 01+ 0O1- 02+ 02-] +Vv 12A 2B -V | TX RX
OUTPUTS INPUT2 AUX 3

Figure 67 - NPN Input 2 Using External Power

4.6 OUTPUTS

Two optocoupled general purpose outputs are available. The meaning of the two outputs
Output 1 and Output 2 can be defined by the user. They are typically used either to signal the
data collection result or to control an external lighting system.

CBX100/500 Function
+V Power Source - Outputs
O1+ Output 1 +
O1- Output 1 -
02+ Output 2 +
02- Output 2 -
Y Power Reference Outputs

The electrical features of the two outputs are the following:

Vce = 30 Vdc max.

Ice = 40 mA continuous max.; 130 mA pulsed max.
VCE saturaion = 1 Vdc max. @ 10 mA

Pp = 80 mW Max. @ 45 °C ambient temp.

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are
correctly decoded.

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.
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OUTPUT CONNECTIONS USING MATRIX 400™ POWER

D

CAUTION

Power is available directly to the Output Device, independently from the

Power Supply Switch inside the CBX.

Output Device

Power to
Output device

Output device
Reference

Output
Signal

 —

 — )| m—

 —

 —| | —

 —

 —

 —

4

OO

O

OO

O

O

O

+V V. 01+ O1-

OUTPUTS

02+ 02-

+V

I2A 12B
INPUT2

-V

>

RX

AUX

d

Figure 68 - Open Emitter Output Using MATRIX 400™ Power

Output Device

Power to
Output device

Output device
Reference

Output
Signal

o | | —

|| —

—

—

4

OO

OO

O

O

+V V. 01+ O1-

OUTPUTS

02+ 02-

+V

I2A 12B
INPUT2

-V

>

RX

AUX

J

Figure 69 - Open Collector Output Using MATRIX 400™ Power

OUTPUT CONNECTIONS USING EXTERNAL POWER

Output Devic

Pulled up to External
Output Device Power

Output
Signal

e

|| —

—l

—l

—l

—l

—l

—l

—l

—l

OO

O

O

O

O

O

O

O

O

+V -V 01+ O1-

OUTPUTS

02+ 02-

+V

12A 12B
INPUT2

-V

>
AUX

RX

J

Figure 70 - Output Open Emitter Using External Power

Output Devic

Output
Signal

e

Pulled down to External
Output Device Reference

OUTPUTS

INPUT2

| | —] | | o | |} e s |
OO O|0|0|0|O00O
4V vV O1+ O1- 02+ O2-|+ 12A 128 v | X RX

AUX

J

Figure 71 - Output Open Collector Using External Power
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4.7 EXTERNAL LIGHTING SYSTEMS

If an External llluminator is used, it can be powered from the CBX connection box. It must be
connected to the Vdc and GND terminal clamps.

D

CAUTION

Power is available directly to the llluminator, independently from the Power
Supply Switch inside the CBX.

In the case of the LT-100, LT-200 or LT-300 illuminators, one of the available digital outputs
must be connected as the control signal. In VisiSet™, configure the Output Line Function
parameter to "External Lighting System" and the Matrix Output x External Lighting System
Mode parameter to "Triggered".

Control Signal for
LT-100, LT-200 or
LT-300 illuminators

O[l

O[l

o[l

O|@®OO000

O[l
o[l

+V

-V 01+ O1- 02+ 02-] +Vv I2A 2B -V
OUTPUTS INPUT2

T™X RX
AUX

—l

0l00I0/01010

o

Vdc GND | &

POWER

K

REF 1D+ ID- |5, +V
%
ID-NET %

MA  11B
TRIGGER

-V |sGND
AUX

Power to External

llluminator

Figure 72 — External Lighting System Connections

Below is a table summarizing the various External llluminator wiring and power requirements:

llluminator Wire Color CBX/Matrix Signal Meaning
LT-100 Red Vdc 10 to 30 Vdc
LT-200 Black GND Ground
Blue 0O1- or O2- Control Signal -
White 01+ or O2+ Control Signal +
LT-300 Brown Vdc 10 to 30 Vdc
Black GND Ground
Yellow/Green Earth Shield/Earth Ground
Blue 0O1- or O2- Control Signal -
White 01+ or O2+ Control Signal +
LT-210, LT-314, White Vdc 24 Vdc
LT-316, LT-410 Black GND Ground
LT-510, LT-511 Shield Earth Shield/Earth Ground
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4.8 USER INTERFACE - HOST

The following table contains the pinout for standard RS232 PC Host interface. For other user
interface types please refer to their own manual.

RS232 PC-side connections

1 5 1 13

&...................'..... /

6 9 14 25

9-pin male connector .
25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 TX 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS
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5 MATRIX 400™ CONNECTOR ELECTRICAL CONNECTIONS

5.1 M16 19-PIN CONNECTOR

The Matrix 400™ reader is equipped with an M16 19-pin male connector (Binder, 423
Series) for connection to the power supply, serial interfaces and input/output signals. The
details of the connector pins are indicated in the following table:

Figure 73 — M16 19-pin Male Connector

19-pin M16 male connector pinout

Pin Name Function

A Vdc Power supply input voltage +

L GND Power supply input voltage -

K CHASSIS Cable_ shield internally connected by capacitor to the

chassis

B 1A External Trigger A (polarity insensitive)

C 1B External Trigger B (polarity insensitive)

D 12A Input 2 A (polarity insensitive)

E 12B Input 2 B (polarity insensitive)

H o1+ Output 1 +

F O1- Output 1 -

G 02+ Output 2 +

I 02- Output 2 -

S RX Auxiliary RS232 RX

©) TX Auxiliary RS232 TX

R ID+ ID-NET™ network +

P ID- ID-NET™ network -

. RS485 RS485
Pin Name RS232 Full-Duplex Half-Duplex
M MAIN X TX+ RTX+
U INTERFACE RX *RX+

N (SW RTS TX- RTX-
T SELECTABLE) CTS *RX-

* Do not leave floating, see par. 5.4.2 for connection details.

In order to meet EMC requirements:

e connect the reader chassis to the plant earth ground by means of a flat copper braid
shorter than 100 mm;

e connect the main interface cable shield to pin K of the 19-pin connector;
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5.2 M12-D 4-PIN CONNECTOR (ETHERNET)

In Matrix 400 xxx-x1x models, an M12 D-Coded connector is provided for the on-board
Ethernet connection. This interface is IEEE 802.3 10 BaseT and IEEE 802.3u 100 BaseTx
compliant. See par. 5.7 for connection details.

(&

Figure 74 - M12 D-Coded Female Ethernet Network Connector

M12 D-Coded Ethernet Network Connector pinout

Pin Name Function
1 TX + Transmitted data (+)
2 RX + Received data (+)
3 TX - Transmitted data (-)
4 RX - Received data (-)

5.3 POWER SUPPLY

Power is supplied to the reader through the pins provided on the M16 19-pin connector (see
Figure 75):

MATRIX USER INTERFACE

V+ (10 - 30 Vdc)

GND L | ( ) V- (Ground)

SHIELD CHASSIS

—
Earth Ground ——= = Earth Ground

Figure 75 - Power Supply Connection

The allowed supply voltage range is 10 to 30 Vdc.

5.4 MAIN SERIAL INTERFACE

The signals relative to the following serial interface types are available on the M16 19-pin
connector:

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. The RS485 half duplex is automatically set
whenever MUX32 communication protocol is enabled. For more details refer to the
"Communication" folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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5.4.1 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins of the M16 19-pin connector are used for RS232 interface connection:

Pin |Name Function

M TX Transmit Data

U RX Receive Data

N RTS Request To Send
T CTS Clear To Send

L GND Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

MATRIX

USER INTERFACE

: M :
TX i /\ /\ RXD
RX | : TXD
P NG
RTS Handshaking
T: Signals

CTS i

Reference Ground

GND

Chassis SHIELD

Earth Ground = Earth Ground

Figure 76 - RS232 Main Interface Connections

The RTS and CTS signals control data transmission and synchronize the connected devices.

START OF END OF
ny TRANSMISSION TRANSMISSION
RTS
-V — f—

: DATA DATA :
| TRANSMISSION TRANSMISSION

+V | :
TRANSMISSION STOPPED |

+V &

cTS

Ry

| |
IDLE

|
| | |
|

/.
Figure 77 - RS232 Control Signals

AN

IDLE

ENABLED ENABLED

DISABLED

If the RTS/CTS handshaking protocol is enabled, Matrix 400™ activates the RTS output to
indicate a message is to be transmitted. The receiving unit activates the CTS input to enable
the transmission.
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5.4.2 RS485 Full-Duplex Interface

The RS485 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The following pins of the M16 19-pin connector are used for RS485 full-duplex
communication:

Pin |Name Function
M TX+ RS485 Transmit Data (+)
N TX- RS485 Transmit Data (-)
U RX+ RS485 Receive Data (+)
T RX- RS485 Receive Data (-)
L GND Ground
MATRIX USER INTERFACE
M /\ +
N RX485
v )
T TX485
RX- i :

Reference Ground

GND

Chassis SHIELD

Earth Ground —= = Earth Ground

Figure 78 - RS485 Full-duplex Connections

@ For applications that do not use RX485 signals, do not leave these lines
floating but connect them to GND as shown below.
NOTE

MATRIX USER INTERFACE

/ \ ) RX485

RX- |

Reference Ground

GND

SHIELD

Chassis

Earth Ground —= = Earth Ground

Figure 79 - RS485 Full-duplex Connections using Only TX Signals

66



19-PIN CONNECTOR ELECTRICAL CONNECTIONS o

5.4.3 RS485 Half-Duplex Interface

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.

NOTE

The RS485 half-duplex (3 wires + shield) interface is available for polled communication
protocols.

It can be used for Multidrop connections with a Datalogic Multiplexer, (see par. 6.5) exploiting
a proprietary protocol based on polled mode called MUX32 protocol, where a master device
polls slave devices to collect data.

The following pins of the M16 19-pin connector are used for RS485 half-duplex
communication:

Pin |Name Function
M RTX+ RS485 Receive/Transmit Data (+)
N RTX- RS485 Receive/Transmit Data (-)
L GND Ground
MATRIX MULITPLEXER

M
A A\ RTX485+

RTX+ |

o[
RTX- i RTX485-
GND \ ’ \ ’ RS485REF
Chassis__ SHIELD : H
Earth Ground —= = Earth Ground

Figure 80 - RS485 Half-duplex Connections
This interface is forced by software when the protocol selected is MUX32 protocol.

In a Multiplexer layout, the Multidrop address must also be set via serial channel by the
VisiSet™ utility or by the Host Programming Mode.
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The figure below shows a multidrop configuration with Matrix 400™ readers connected to a
Multiplexer.

& This is an example of multidrop wiring. Consult the multiplexer manual for
complete wiring instructions.

CAUTION

P Max 2 m O
= "l
120 Ohm WA —
Reader —@ 1
#x —@ ®
(up to 31)
@ PG-6000 e
= (L
Reader @ §
A g
D °
-c
o
® PG-6000 %
= o =
x
N
Reader @ S
v N t :

d‘f) PG-6000 <::>

MULTIDROP+
120 Ohm é MULTIDROP-

Multiplexer | MULTIDROP GND¢{

I |Z PG-6000
| F
@ o 2
£ v v
£ 1 Multidrop Cable SHIELD
p =
RS232/RS485 2

Figure 81 - Matrix 400™ Multidrop Connection to a Mutiplexer
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5.5 ID-NET™ INTERFACE

Pin |Name Function
R ID+ ID-NET™ network +
P ID- ID-NET™ network -
L GND Ground

5.5.1 ID-NET™ Cables

The following instructions are referred to Figure 83, Figure 84 and Figure 85.

« The general cable type specifications are: CATS twisted pair + additional CATS twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 — IEC 62026
UL STYLE 2502 80°C 30V

« Cable Shield MUST be connected to earth ground ONLY at the Master.
« NEVER use ID-NET™ cable shield as common reference.

« The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
« For Common Power Connections use only 2 wires (R and P).

DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

- Reader's chassis may be connected to earth.

« Network inside the same building.

Baudrate Table

Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps

Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.

The default ID-NET™ baudrate is 500 kbps. Lower ID-NET™ baudrates
allow longer cable lengths. The baudrate is software configurable by

NOTE authorized Datalogic Automation personnel only.
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5.5.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the
Host.

Max ID-NET™ Response Time

240

220

5
K
S

200

180

160

140

120

O“
R

100 =

3
R

:
80 e —
”

Response Time (ms)

60 et

40

20

o 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Number of Nodes
= 500 kbps = = 250 kbps = seeesees 125 kbps

Figure 82 — ID-NET™ Response Time

CONDITIONS:

e |D-NET™ M/S Synchronized layout
e message length = 50 bytes per node
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RS232/RS485
HOST

Max 0.3 m

120 Ohm

Slave

|

<
Reader —®

1\ 2,
(up to 31) C) .
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Reader
Slave

(LD
&
D
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® PG-6000 </-—\>

Main Interface
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®
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Figure 83 — ID-NET™ Network Connections with isolated power blocks
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72
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120 Ohm

0|

Figure 84 - ID-NET™ Network Connections with Common Power Branch Network
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Max 0.3 m

120 Ohm

S
IS

Figure 85 — ID-NET™ Network Connections with Common Power Star Network
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5.5.3 ID-NET™ Network Termination

The network must be properly terminated by a 120 Ohm resistor at the first and last reader of
the network.

5.6 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication
folder of the VisiSet™ utility program.

The following pins of the M16 19-pin connector are used for auxiliary interface
communication:

Pin |Name Function
O X Transmitted data
S RX Received data
L GND Ground
MATRIX USER INTERFACE

LR EA A TXD

o [ 1 [ | ota oo
\

’ Ground

RX i

X |

GND

SHIELD

Chassis

Earth Ground —= = Earth Ground

Figure 86 - RS232 Auxiliary Interface Connections Using 19-pin Connector
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5.7 ETHERNET INTERFACE (MATRIX 400 XXX-010 MODELS ONLY)

The Ethernet Interface can be used for TCP/IP communication with a remote or local host
computer by connecting the reader to either a LAN or directly to a host PC.

The following is an example of a connection to a LAN using a CAB-ETH-MOx straight
through cable:

M12 D-Coded Connector Pinout
Pin Name Function
1 TX+ Transmitted data (positive pin)
2 RX+ Received data (positive pin)
3 TX- Transmitted data (negative pin)
4 RX- Received data (negative pin)
MATRIX LAN

Figure 87 - Straight-Through Cable

For direct connection to a PC use the CAB-ETH-MOx cable with a crossover adapter.

On the Matrix 400™ Ethernet interface the following communication channels are available:
o Data Socket
¢ Image Socket
e WebSentinel Socket
e Image FTP Client
e HTTP Server
e Email Client
e Ethernet IP

For further details refer to the Ethernet Folder in the VisiSet™ Help On Line and to the
"Matrix Ethernet Service Guide.pdf" document provided as supplementary documentation.
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5.8 INPUTS

There are two optocoupled polarity insensitive inputs available on the M16 19-pin connector
of the reader: Input 1 (External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
e reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
¢ match code storage command when the Match Code option is enabled

The electrical features of both inputs are:

INPUT |V ag| Min. ||V ag| Max. | v Max
Open oV 2V 0 mA
Closed 45V 30V 10 mA

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the minimum
pulse duration is = 0.5 milliseconds. This value can be increased through the software
parameter Debounce Filter, see the Digital I/O folder in the VisiSet™ Help On Line for further
details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

Polarity insensitive inputs assure full functionality even if pins A and B are
exchanged.

NOTE

The connections are indicated in the following diagrams:

Pin |Name Function
A Vdc Power Supply input voltage +
B 1A External Trigger A (polarity insensitive)
C 1B External Trigger B (polarity insensitive)
L GND Power Supply input voltage -

The yellow Trigger LED (Figure 19, 5) is on when the active state of the External Trigger
corresponds to ON.
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EXTERNAL TRIGGER INPUT PNP PH-1

Matrix 400™ PNP PH-1 wires
: i Vde (brown) +10-30 Vdc
1A (black) NO
1B
{ oD (blue) 0V

Figure 88 - External Trigger Using PNP PH-1 Photocell

EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 400™ POWER

Matrix 400™ EXTERNAL TRIGGER

%{— Signal

\Y

Ground

Figure 89 — External Trigger PNP Using Matrix 400™ Power

Matrix 400™ EXTERNAL TRIGGER

Fﬂ— Signal
Ground

Figure 90 - External Trigger NPN Using Matrix 400™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

Matrix 400™ [Vext 30 Vdc max.| gyrerNaL TRIGGER

\Y

..............

A HA Signal

J5
&
g

s

Figure 91 - External Trigger PNP Using External Power
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Matrix 400™

[Vext 30 Vdc max.]| EXTERNAL TRIGGER

1A

\

F‘— Signal

Figure 92 - External Trigger NPN Using External Power

Pin |Name Function
A Vdc Power Supply input voltage +
D I2A Input 2 A (polarity insensitive)
E 2B Input 2 B (polarity insensitive)
L GND Power Supply input voltage -

INPUT 2 CONNECTIONS USING MATRIX 400™ POWER

Matrix 400™

INPUT DEVICE

Vv
&{— Signal

Ground

Figure 93 - Input PNP Using Matrix 400™ Power

Matrix 400™

INPUT DEVICE

Figure 94 - Input NPN Using Matrix 400™ Power
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INPUT 2 CONNECTIONS USING EXTERNAL POWER

Matrix 400™

an

[Vext 30 Vdc max.| \\puT DEVICE

Signal

Figure 95 - Input PNP Using External Power

Matrix 400™

[Vext 30 Vdc max.] INPUT DEVICE

i | Di 2A % v

F‘— Signal

Figure 96 - Input NPN Using External Power

5.9 OUTPUTS

Two opto-coupled general purpose outputs are available on the M16 19-pin connector. The
meaning of the two outputs Output 1 and Output 2 can be defined by the user. They are
typically used either to signal the data collection result or to control an external lighting

system.

The pinout is the following:

Pin |Name Function
H o1+ Configurable digital output 1 - positive pin
F 0O1- Configurable digital output 1 - negative pin
G 02+ Configurable digital output 2 - positive pin
I 02- Configurable digital output 2 - negative pin

The electrical features of the two outputs are the following:

OUTPUT I oad Vout
Open 0 mA 30 Vdc Max
Closed 10 mA 1.8 Vdc Max

PD = VOut X IoLoad = 170 mW MaX.

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are

correctly decoded.

79



o MATRIX 400™ REFERENCE MANUAL

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.

MATRIX USER INTERFACE

Vext 30 Vdc max
f : -
. ! ! <
H ' Vou | Load
h : Fil
, i . i

L

Figure 97 - Open Emitter Output Connection

MATRIX USER INTERFACE
Vext 30 Vdc max

- L

Figure 98 - Open Collector Output Connection
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5.10 USER INTERFACE

RS232 PC-side connections

1 13

\.1:......................./

25

6 9
9-pin male connector 25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 TX 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS

How To Build A Simple Interface Test Cable:

The following wiring diagram shows a simple test cable including power, external (push-
button) trigger and PC RS232 COM port connections.

M16 19-pin female 9-pin D-sub female
o TX /A N\ 2 ey
s RX [ ] | x | W Pc

4
L _GND 1

Matrix 400™ « j A _vdc

B [MA

C 1B
B Power Supply
I Power GND

VS (10 -30 VDC)

{ )
—__ \J

[
*-—

Trigger I—l

Figure 99- Test Cable for Matrix 400™
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6 TYPICAL LAYOUTS

The following typical layouts refer to system hardware configurations. However, they also
require the correct setup of the software configuration parameters. Dotted lines in the figures
refer to optional hardware configurations within the particular layout.

6.1 POINT-TO-POINT

In this layout the data is transmitted to the Host on the main serial interface. The RS232
auxiliary interface can be used for reader configuration by connecting a laptop computer
running VisiSet™. Host Mode programming can be accomplished either through the main
interface or the Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the main interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

PG6000 Host
==
CAB-MSxx 1=
i — I
Matrix 400™ [ LrmeaaR e
| Terminal
|
I‘ 1T 1 ﬂ— —_— = = I ® Main Serial Interface (RS232 or RS485 Full-Duplex)
| | @ Auxiliary Serial Interface (Local Echo) (RS$232)

® External Trigger (for One Shot or Phase Mode)

Figure 100 — Serial Interface Point-to-Point Layout
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In this layout a single reader functions as a Slave node on a Fieldbus network. The data is
transmitted to the Host through an accessory Fieldbus interface board installed inside the
CBX500 connection box.

Reader configuration can be accomplished through the Auxiliary interface using the VisiSet™
configuration program or Host Mode programming.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the Fieldbus interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

Power

|

CBX500

Matrix 400™ | : @
I_ - - el
— ®
@ Fieldbus Interface (Profibus, DeviceNet, etc.)
@ Auxiliary Serial Interface (Local Echo) (RS232)
Host ® External Trigger (for One Shot or Phase Mode)
ojojojojojojo (-] (] ojo (] ]
[J |!| |E| |l:!| |E| |!| |£| |!| |!| |E| o o o

Figure 101 — Fieldbus Interface Point-to-Point Layout
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6.2 PASS-THROUGH

Pass-through mode allows two or more devices to be connected to a single external serial
interface.

Each reader transmits the messages received by the Auxiliary interface onto the Main
interface. All messages will be passed through this chain to the host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

Applications can be implemented to connect a device such as a hand-held reader to the
Auxiliary port of the last reader in the chain for manual code reading capability.

The Main and Auxiliary ports are connected as shown in the figure below:

® @ ® @ » ®

/L
7/
Device#1 Device#2 Device#n
I— ——-—ﬂ—d I—-——-—ﬂ—d I_.___
1 1 1
Power

@® Main Serial Interface (RS232 only)

@ Auxiliary Serial Interface (RS$232)

® External Trigger (for One Shot or Phase Mode)

\

Figure 102 — Pass-Through Layout
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uTsS

An alternative Pass-Through layout allows the more efficient ID-NET™ network to be used.
This layout is really an ID-NET Master/Slave Multidata layout which also allows each reader
(Master and Slaves) to accept input on the Auxiliary interface, for example to connect a
device such as a hand-held reader for manual code reading capability.

Each Matrix 400™ transmits its own messages plus any messages received by its Auxiliary
interface onto the ID-NET™ interface. The Master passes all messages to the Host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

@ Auxiliary Serial Interface (RS232)

o 1o et 1T | Wele - ™
[ o @ ID-NET

Figure 103 — Pass-Through On ID-NET™ Layout

@ Main Serial Interface (RS232 or RS485)

® External Trigger (for One Shot or Phase Mode)

/ /
//
7/
Master Slave#2 Slave#n
O | Ol | |
| ®)
H{--t{F—= H{--t{F—= H{--t {F—=
1 1 1
Power @
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6.3 ID-NET™

The ID-NET™ connection is used to collect data from several readers to build a multi-point or
a multi-sided reading system; there can be one master and up to 31 slaves connected
together.

The slave readers are connected together using the ID-NET™ interface. Every slave reader
must have an ID-NET™ address in the range 1-31.

The master reader is also connected to the Host on the RS232/RS485 main serial interface.
For a Master/Slave Synchronized layout the External Trigger signal is unique to the system;

there is a single reading phase and a single message from the master reader to the Host
computer. It is not necessary to bring the External Trigger signal to all the readers.

In the Master/Slave Synchronized layout the Master operating mode can only be set to
Phase Mode.

The main, auxiliary, and ID-NET™ interfaces are connected as shown in the figure below.

® © ya

Slave#1 Slave#n

(&4
=0

Power --H
1
Master
Host @ Main Serial Interface (RS232 or RS485)

@ External Trigger
® ID-NET™ (up to 16 devices - practical limit)

Figure 104 — ID-NET™ M/S Synchronized Layout

86



TYPICAL LAYOUTS o

For a Master/Slave Multidata layout each reader has its own reading phase independent
from the others; each single message is sent from the master reader to the Host computer.

OO /L

Master Slave#1 |

=

) a1

4o

Terminal I

L1 | I
Power
Host @ Main Serial Interface (RS232 or RS485)
| @ Auxiliary Serial Interface (Local Echo) (RS232)
‘ i (® External Trigger (for One Shot or Phase Mode)
LEI‘ @ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 105 — ID-NET™ M/S Multidata

The auxiliary serial interface of the slave readers can be used in Local Echo
communication mode to control any single reader (visualize collected data)
@ or to configure it using the VisiSet™ ultility.

The ID-NET™ termination resistor switches must be set to ON only in the first
NOTE and last CBX connection box.

87



o MATRIX 400™ REFERENCE MANUAL

Alternatively, the Master reader can communicate to the Host as a Slave node on a Fieldbus
network. This requires using an accessory Fieldbus interface board installed inside the
CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of each individual
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming. See par. 2.3.1 for details.

Power 7/
7/
H® g Slavei#1 Slave#n |
5 O, ° | — @) ©

Master

®

Host
@ Fieldbus Interface
il B i i e i K A1 ° @ External Trigger (for One Shot or Phase Mode)
|i| |}| |i| H |i| |}| |i| |i| |}| ® ID-NET™ (up to 16 devices - practical limit)
ojojojojojojo [J o ojo o (]

Figure 106 — ID-NET™ Fieldbus M/S Synchronized Layout

Power 7 /
7/
Master Slavei#1 2 Pg =20
1 m Te |
. I ' Terminal I '
H- o —- H- o —-
1 1
@ @ Fieldbus Interface

@ Auxiliary Serial Interface (Local Echo) (RS$232)
°© [0 o ® External Trigger (for One Shot or Phase Mode)

ojojojojojo o
|i| H |i| |}| |i| |}| |i| |i| H @ ID-NET™ (up to 32 devices, max network extension of 1000 m)
ojojojojojo ]

Figure 107 — ID-NET™ Fieldbus M/S Multidata
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6.4 RS232 MASTER/SLAVE

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
NOTE

The RS232 master/slave connection is used to collect data from several readers to build either
a multi-point or a multi-sided reading system; there can be one master and up to 9 slaves
connected together.

The Slave readers use RS232 only on the main and auxiliary serial interfaces. Each slave
reader transmits the messages received by the auxiliary interface onto the main interface. All
messages will be passed through this chain to the Master.

The Master reader is connected to the Host on the RS232/RS485 main serial interface.

There is a single reading phase and a single message from the master reader to the Host
computer.

In this layout the Master operating mode can be set only to Phase Mode.

The Phase ON/OFF signals must be brought only to the Master. It is not necessary to
bring them to the Slave readers.

The main and auxiliary ports are connected as shown in the figure below.

® @ ® @ L ®

/L
7/

Slave#1 Slave#n |

Power

Master

@® Main Serial Interface (Slaves RS232 only)
Host @ Auxiliary Serial Interface (RS232)
® External Trigger

Figure 108 — RS232 Master/Slave Layout

89



o MATRIX 400™ REFERENCE MANUAL

6.5 MULTIPLEXER

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.

NOTE

Each reader is connected to a Multiplexer (for example MX4000) with the RS485 half-duplex
main interface through a CBX connection box.

Before proceeding with the connection it is necessary to select the MUX32 communication
protocol and the multidrop address for each reader.

L

/
/L
7/

®

[ R ERRRE ()

®

5

5

H-- o= H--Hop=

I I | I

Power

® Main Serial Interface (RS485 Half-Duplex)
@ Auxiliary Serial Interface (Local Echo) (RS232)
Host ® External Trigger (for One Shot or Phase Mode)

Figure 109 - Multiplexer Layout

The auxiliary serial interface of the slave readers can be used in Local Echo communication
mode to control any single reader (visualize collected data) or to configure it using the
VisiSet™ utility.

Each reader has its own reading phase independent from the others. When One Shot or
Phase Mode operating mode is used, the reader can be activated by an External Trigger (for
example a pulse from a photoelectric sensor) when the object enters its reading zone.
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6.6 ETHERNET CONNECTION (MATRIX 400 XXX-010 MODELS ONLY)

For Matrix 400 XXX-010 models, the Ethernet connection is possible in two different layouts.
In both layouts, before proceeding with the connection, it is necessary to configure the reader
Ethernet parameters via VisiSet™. For further details, see the Ethernet Folder in the
VisiSet™ Help On Line.

In a Point-to-Point layout the reader is connected to a local host by using a CAB-ETH-MO0x
cable with a crossover adapter.

Crossover
CAB-ETH-MO0x Adapter - ¥ e
® .| i
6 ! |=
CBX ‘
= === G
/ : k_’ff_‘:. ” {EEa TR
Host

PG 6000

® Ethernet Interface (with Crossover Adapter)
@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 110 - Ethernet Point-to-Point Layout
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When using a Local Area Network (LAN), one or more Matrix 400 XXX-010s can be
connected to the network by using CAB-ETH-MOXx straight through cables:

X
S
=
I
m. -0
m
<
o |
z |
[72]
= 1 |
: R -
I3) (
.
‘ |
Power
HOST
NETWORK ‘7
= | |
=
i / |
® Ethernet Interface (Straight Through Cables) | l L—:

@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 111 - Ethernet Network Layout
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7 READING FEATURES

7.1 OPTICAL ACCESSORY SELECTION

Referring to Figure 112 and the formula below, use the data in the following table to calculate
the FOV for your application.

Model Lens Vi:gi?foﬁ?zle Vie{llv‘ier:ﬂgt;icAar:gle Vi%v;/iar;goﬁglgle Min Foct:mDistance
LNS-1109 9 mm 48.5° 39.5° 60° 85
. LNS-1112 12.5 mm 37° 30° 46.5° 85
M:ggi(oigo LNS-1116 16 mm 28.5° 23° 36° 85
(SXGA) LNS-1125 25 mm 18.5° 15° 23.5° 135
LNS-1135 35 mm 13° 10,5° 16.5° 235
LNS-1150 50 mm 9° 7° 11.5° 500
LNS-1006 6 mm 59.5° 46.5° 71° 85
LNS-1109 9 mm 40.5° 31° 49.5° 85
Matrix 400 LNS-1112 12.5 mm 31° 23.5° 38° 85
600-0x0 LNS-1116 16 mm 24° 18° 30° 85
(UXGA) LNS-1125 25 mm 15° 11.5° 19° 135
LNS-1135 35 mm 11° 8.5° 13.5° 235
LNS-1150 50 mm 7.5° 5.5° 9.5° 500

The viewing angle has a tolerance of + 1° depending on the focus distance.

where:

FOV, = 2 Bd + 35 mm) tan (ax/zﬂ

FOV, = horizontal, vertical or diagonal FOV

ax = horizontal, vertical or diagonal viewing angles.
d = focus distance

FOV
plane

Figure 112 — Reading Distance References
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Example:

The FOV for a Matrix 400 600-0x0 base using the 16 mm lens at a focus distance of 200
mm is:

FOVy =2 [(200 mm + 35 mm) tan (24°/2)] = 100 mm
FOVy =2 [(200 mm + 35 mm) tan (18°/2)] = 74 mm
7.2 HORIZONTAL FOV VS. READING DISTANCE DIAGRAMS

The following graphs represent the Horizontal Field of View (FOV) and Reading Distance
based on the combination of a certain sensor (Matrix 400™ base model) and a certain lens.

Each point represents the maximum achievable Field of View with the selected code
resolution (in this point DOF is limited).

The following diagrams are given for typical performance at 25°C using

high quality grade A symbols according to ISO/IEC 15416 (1D code) and

ISO/IEC 15415 (2D code) print quality test specifications. Testing should

be performed with actual application codes in order to maximize the
NOTE application performance.

7.21 How to Use the Diagrams

TTTTTT] J
35 | For a given code resolution, '50/ p-50 o 0/‘
the blue line represents the
maximum  Horizontal FOV. ]
30 | The reading distance can be e
selected by changing the lens.
'g o.3sL./ /.r 0.38 L& 038
£ 2 -
B - 0.33 o 00.3 /4_0.3
hrd > T 1'4.!! Pl
= 20
-g 0.25 / / 0.25 /,4/0 25
E 15 020 & 020 020 Each point represents the maximum FOV for a given
o ) / ) e code resolution.
T e You can read this resolution code with the same
e
10 p-15 A oq 018 lens at shorter distances but sacrificing FOV.
1.0/.1 ./. 0.10 ’ ‘
5 For a given Reading Distance you must
select the lens that is able to read your
0 code resolution.

0 10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200 210 220 230
Reading Distance (cm)

—8— SXGA - 25 mm —@— SXGA - 35 mm —&— SXGA - 50 mm
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7.2.2 1D (Linear) Codes

1D Codes — Matrix 400 400-0x0 (SXGA)
9 mm, 12.5 mm, 16 mm

40
0150 e 050 0.50
. 0® / 0504
30
’g 0 V /o/o 38 0.38
~— 25
> 0.33 0.33 0.33
8 0.30 / 6./ /«{
= 20
- 0. / 25 0.25
6 / / Code Resolution Conversion
215 0.20 0.20 £ 0.20 0.10 mm (4 mils)
8 vl el " 0.12 mm (5 mils)
0.15 mm (6 mils)
10 o5 o] _uods_are 0.20 mm (8 mils)
0129 /-12 0.25 mm (10 mils)
oo 0.30 mm (12 mils)
5 0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)
0 . . . . .
0 5 10 15 20 25 30 35 40 45 50 55 60 65 70
Reading Distance (cm)
—8—SXGA -9 mm —@—SXGA - 12.5 mm —&— SXGA - 16 mm
1D Codes — Matrix 400 400-0x0 (SXGA)
25 mm, 35 mm, 50 mm
40
50 0.50 o.Jo
T
30 /
_ 0.38 / 0.38 L& 038
§ . v A
> 0.33 o 1970.33 /4 0.3
8 " 0.30 / ;{m |_«"0.30
© / o
- 0.25 0.25 0.25
S / L Code Resolution Conversion
N .
g 15 020 & / 0.20 /J 0.20 0.10 mm (4 mils)
0.12 mm (5 mils)
T / ] ,
D15 8 015 0.15 0.15 mm (6 mils)
10 0.20 mm (8 mils)
4 0.25 mm (10 mils)
10 0.10
e 0.30 mm (12 mils)
5 0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)
0

0O 10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200 210 220 230
Reading Distance (cm)

| —@—SXGA - 25 mm —@— SXGA - 35 mm —A— SXGA - 50 mm |

1D Codes — Matrix 400 600-0x0 (UXGA)
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9 mm, 12.5 mm, 16 mm

0.500

_A 0.50

/
[0.38

0.12

0.83 "] ‘/o 33 1033
J.yf )430 ,A/030
O.V /0/ 0.25 = 0.25
0.20 / /. 0.20 /n/o.zo
015 ¢ /o/o.ﬁ/x 0.15
12

0.10 mm (4 mils)
0.12 mm (5 mils)
0.15 mm (6 mils)
0.20 mm (8 mils)
0.25 mm (10 mils)

Code Resolution Conversion

Reading Distance (cm)

—&— UXGA - 25 mm —@— UXGA - 35 mm —&— UXGA - 50 mm

0.10 1047010
«? 0.30 mm (12 mis)
y 0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)
5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 100 105 110
Reading Distance (cm)
—— UXGA - 9 mm —8— UXGA - 12.5 mm —&— UXGA - 16 mm
1D Codes — Matrix 400 600-0x0 (UXGA)
25 mm, 35 mm, 50 mm
0.50 ® _® 050 0.50 4
0.38 / -n/aa ‘/0138/
0.33/ 0.33 0.33
0.30 / /'/o 30 0.30
Code Resolution Conversion
°y /'/.25 0.25
0.10 mm (4 mils)
0.20 0.20 0bo 0.12 mm (5 mils)
4T 0.15 mm (6 mils)
0.15 15 & 0.15 0.20 mm (8 mils)
0-12/ 0.12 0.12 0.25 mm (10 mils)
010 .10 0.10 0.30 mm (12 mils)
//( il 0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)
25 50 75 100 125 150 175 200 225 250 275 300 325

350
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7.2.3 2D (Bi-dimensional) Codes

2D Codes — Matrix 400 400-0x0 (SXGA)
9 mm, 12.5 mm, 16 mm

20

?

/ "

0.33 0.33

0.30 0.30

4 0.25

0.20

Horizontal FOV (cm)

A

Code Resolution Conversion

0.10 mm (4 mils)
0.12 mm (5 mils)
0.15 mm (6 mils)
0.20 mm (8 mils)
0.25 mm (10 mils)
0.30 mm (12 mils)
0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)

0 5 10 15 20 25
Reading Distance (cm)

—8— SXGA - 9 mm —@—SXGA - 12.5 mm —&— SXGA - 16 mm

2D Codes — Matrix 400 400-0x0 (SXGA)
25 mm, 35 mm, 50 mm

20

30

35

0.50/

15

| A 0.50

0.38 //0 38 0.38

0{33 0.33 0.33

0.30 0.30 0.30
10 /

Horizontal FOV (cm)

0.20 / 0.20

4 Code Resolution Conversion

0.10 mm (4 mils)
0.12 mm (5 mils)
0.15 mm (6 mils)
0.20 mm (8 mils)
0.25 mm (10 mils)
0.30 mm (12 mils)
0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)

0 10 20 30 40 50 60 70 80 90

Reading Distance (cm)

—8—SXGA - 25 mm —@— SXGA - 35 mm —&— SXGA - 50 mm

100 110

120
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2D Codes — Matrix 400 600-0x0 (UXGA)
9 mm, 12.5 mm, 16 mm

0.50 /. )

|4 0.50

0.38 !
0.33 / o033 0.33

25 6.25 0l25
Code Resolution Conversion
0.20 0.20 0.20 0.10 mm (4 mils)
0.12 mm (5 mils)
0157 515 0.15 mm (6 mils)
12 0.20 mm (8 mils)
A 0.25 mm (10 mils)
0.30 mm (12 mils)
0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)
5 10 15 20 25 30 35 40 45 50 55
Reading Distance (cm)
—0— UXGA - 9 mm —@—UXGA - 12.5 mm —A— UXGA - 16 mm
2D Codes — Matrix 400 600-0x0 (UXGA)
25 mm, 35 mm, 50 mm
0.? /. 0.50 //‘ 0.50
0-3'/ / 0.38 /4%
0 33./ o 0133 o033
0.30 / 0.30 / 0.30
0.25 /‘/-/025 /4{25
/ Code Resolution Conversion
o.zo/ /./o.zo /o.zo 0.10 mm (4 mils)
/ 0.12 mm (5 mils)
0.15 0.15 &0.15 0.15 mm (6 mils)
0.20 mm (8 mils)
shig o0 0.25 mm (10 mils)
0.30 mm (12 mils)
0.33 mm (13 mils)
0.38 mm (15 mils)
0.50 mm (20 mils)
10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180

Reading Distance (cm)

—8— UXGA - 25 mm —@—UXGA - 35 mm —&— UXGA - 50 mm
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7.3 MAXIMUM LINE SPEED AND EXPOSURE TIME CALCULATIONS

The Exposure Time (or Shutter) parameter defines the time during which the image will be
exposed to the reader sensor to be acquired. This parameter depends heavily on the
environmental conditions (external lighting system, image contrast etc.).

In general, a longer time corresponds to a lighter image but is susceptible to blurring due to
the code movement; a shorter exposure time corresponds to a darker image.

The following considerations must be applied only when the internal

lighting system and 2D codes are used. The Maximum line speed allowed

for linear codes or postal code reading applications heavily depends on the

direction of symbol movement. When the direction of movement is parallel
NOTE to the elements of the code, the maximum speed is greater.

Assuming:
e X: Code Resolution (mm)
o Texp: Exposure Time (s)

e LS: Line Speed (mm/s)

The essential condition to avoid blurring effects between two adjacent elements in a dynamic
reading application is:

LS # Texp < X

The maximum (theoretical) line speed LS can be calculated as follows:
X / Texp (max) = LS (max)
Example:

A Matrix 400™ 600-010 using:

Internal Lighting Mode = Very High Power Strobe
Exposure Time (x10 us) = 10 (100 us)
Code Resolution (X) = 0.254 mm (10 mils)

has a maximum line speed of:

0.254 (mm) / 0.0001 (s) = 2540 mm/s

Likewise, Texp (max) iS the maximum Exposure Time value that can be used without blurring
for the given application line speed and code resolution. Therefore:

X/LS (max) = Texp (max)
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Texp max) @nd LS max) are represented in the graph below as the curved line for X (code
resolution). Values above the curve result in blurring. In practice, the application values are
somewhere below the theoretical line, (in the green area), due to environmental and other
conditions.

5
SW Limi 3
o
D
5 E
>4
- Q
1
1
1
|
Texp (min) T---
SW/HW Limit Line Speed
E Readable Blurring

For example, the maximum target speed in the application is also affected by these
conditions:

e Code/Background Contrast: maximum speed decreases when decreasing image
contrast (poor quality codes, reflective transparent coverings, different supports and
printing techniques).

e Code Resolution: maximum speed increases when decreasing code resolution, (i.e. 2X).
There is a decrement of overlapping effects between two adjacent elements.

e Tilt Angle: maximum speed decreases when increasing Tilt angle (from 0 to 45
degrees).

The Internal Lighting Mode parameter allows setting the operating mode of the internal
lighting system. The possible values are:

e Disabled: the built-in LED array is turned off all the time. This option can be useful if using
an external lighting system;

o Always ON: the built-in LED array is turned on all the time at the lowest power level. This
option is useful if the LED-array blinking (Strobed operating mode) disturbs the operator.

o Very High/High/Medium/Low-Power Strobed: the built-in LED array is on only during the
image exposure time. Four different lighting levels can be set.

To avoid LED array overheating, for Power Strobed settings, the program

automatically limits the range of allowed values for the Exposure Time

parameter. Therefore, after changes to Internal Lighting Mode, recheck
NOTE Exposure Time.
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1
S
SW Limit -8
o
D o
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x =
@ ]
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Texp (min) -
SW/HW Limit |
1
1
1
1

4

A

Line Speed
B Readable Blurring

Texp (min) IS the minimum Exposure Time value obtainable for the specific application. It can
be evaluated in static reading conditions and depends on the Matrix reader model selected
for the application (internal lighting system, optical lens, diaphragm aperture, reading
distance) and on any external lighting system. It may also depend on code printing quality,
and reader position.
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8 SOFTWARE CONFIGURATION

Software configuration of your Matrix 400™ for static reading or simple code reading
applications can be accomplished by the Rapid Configuration procedure using the X-
PRESS™ HMI (which requires no external configuration program) or by using the VisiSet™
Setup Wizard for easy setup. These procedures are described in chapter 1.

For all other applications use VisiSet™ through the reader serial ports (or Ethernet port for
Matrix 400™ Ethernet models only).

Before using VisiSet™ via Ethernet, it is necessary to configure Matrix 400™
Ethernet port parameters using VisiSet™ via Main or Auxiliary serial port (for

further details refer to the VisiSet™ Help on line).
NOTE

8.1 VISISET™ SYSTEM REQUIREMENTS

To install and run VisiSet™ you should have a Laptop or PC that meets or exceeds the
following:

e Pentium processor

e Win 98/2000, NT 4.0, XP or Vista

e 32 MB Ram

e 5 MB free HD space

e one free RS232 serial port with 115 Kbaud

e SVGA board (800x600) or better using more than 256 colors

8.2 INSTALLING VISISET™

To install VisiSet™, proceed as follows:

1. Turn on the Laptop or PC that will be used for configuration (connected to the Matrix
400™ communication ports).

2. After Windows finishes booting, insert the CD-ROM provided.
Launch VisiSet™ installation by clicking Install.

Follow the instructions in the installation procedure.
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8.3 STARTUP

After completing the mechanical and electrical connections to Matrix 400™, you can begin
software configuration as follows:

1. Power on the Matrix 400™ reader. Wait for the reader startup. The system bootstrap
requires a few seconds to be completed. The reader automatically enters Run Mode.

Run the VisiSet™ program.

Press Connect on the VisiSet™ menu bar. The PC will automatically connect to the
Matrix 400™ reader.

Upon connection, Matrix 400™ exits Run Mode and displays the Main Menu on VisiSet™
with all the commands necessary to monitor your reader's performance. You can select
these commands using the mouse or by pressing the key corresponding to the letter
shown on the button. See Figure 113.

M visiset

File Edit Connect Disconnect Device Options Tools  Help

MATH MEHU
: Matrix 400

M. Setup Wizard Model: 600-010
Communication Port: Auxiliary
F. Calibration Tool
Standard Application Program for Matrix Family Rel. 5.40
V. Symbol Verification Standard Application Program for Ethernet Board Rel. 3.03
MACHUM: O0O07EEDD4389
A. Run Made DHCP di=zabled.
IPF Address: 172.16.11.12
B. Capture Image Subnet Mask: 255.255.0.0
Gateway: 172.16.0.254
C. Decode Last Image DHS1: 172.16.0.21

D. View Last Image BT L
E. Download Last Image

H. Upload Bitmap Image

0. Image Buffer

Terminal
3. Button Function Menu Window

Commands

Window Status Bar

Connection: COSI00320 on COMI ak 115200,M,58,1 Reader Status: OFF LINE MODE Log @ OFF

Figure 113 - Main Window
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8.3.1 VisiSet™ Opti

ons

The Options item from the VisiSet™ menu (see Figure 113) presents a window allowing you

to configure:

VisiSet™ window prop

Sawe Exit

Log

Log
L

Default Dpen State
= OFF

the logging function (Log)

erties (Environment)

M visiset Options

l Enwronmentl Comrmunication ]

options

og File Name

VisiSet™ communication channel (Communication)

E3

|\I|:|gbd

0N AR

Log Print Lewel
f* Everything

" Only Codes

" Only Errors

Delete old log file

Browse

0N

Exat

IE visiset

Sawe Exit

Log

Figure 114 - Options

Options

Enviranment l Communication l

Font & Background

Text example

ChangeFont

Change Background

-Log

Restore Factary Settings

Save Exit

Figure 115 - Options - Environment
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B visiset Options (%]

Save  Exit
Log ] Environment Comrmunication l
Comrunication Channel
& Serial pont " USB " Ethernet
Autoconnect ports Starting port configuration for auto search
Fort Baud rate (bps) Stop bits
W |COMT =
 COMI 2400 o
W |COMZ -
- ComMez 4800 o
[~ |COM3 - ~
9600
[~ |COM4 -
£ 18200 Pl
& MNone
38400
 B7RO0 Loy
+ 115200 " Odd
Exit

Figure 116 - Options — Communication: Serial Port

IE visiset Options

Sawe Exit

Log IEnvwronment Communication

Communication Channel
" Serial port = LSE @+ Ethernet

Device Ethernet Channel Address

IP Address 172161112
IP Port Mumber File IP Port Number

Stop Device Network Searching |

Device D IP Address ‘MACNumber t]

MATRIX 72161112 0007BE004389 -
MATRIX 172161115 0007be003ico

MATRIX 172161116 0007BE00IEIC

MATRIX 1721611171 0007BE002D9E

Exit

Figure 117 - Options — Communication: Ethernet
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8.4

CONFIGURATION

Once connected to Matrix 400™ as described in par. 8.3, you can modify the configuration
parameters as follows:

1.

106

Press the Calibration Tool button from the Main Menu. Matrix 400™ will download its
permanent memory configuration parameters with the default values (if it is the first time)
to VisiSet™. The Calibration Tool window will be displayed together with the Parameter
Setup window working in Interactive Mode (see par. 8.4.1 and par. 8.4.3).

Edit the Matrix 400™ configuration parameters according to your application
requirements.

Use the Calibration Tool to fine tune the reading performance. See par. 8.4.3.

Close the Calibration Tool window and disable the Interactive Mode by pressing the
interactive button.

Save the new configuration to the reader permanent memory by pressing the Send
button.

Close the Parameter Setup window and press Disconnect on the VisiSet™ menu bar
(see Figure 113) or launch Run Mode from the VisiSet™ Main menu.

Disconnect exits closing communication between Matrix 400™ and VisiSet™, and
causes Matrix 400™ to enter Run Mode. The disconnected reader serial port is now
available.

Run command does not close communication between Matrix 400™ and VisiSet™,
and causes Matrix 400™ to enter Run Mode. In this case the reader output messages
are displayed on the VisiSet™ terminal and the statistics are displayed in the
Statistics window (Statistics enabled).
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8.4.1 Edit Reader Parameters

The Parameter Setup window displays the configuration parameters grouped in a series of
folders. Each parameter can be modified by selecting a different item from the prescribed list
in the box, or by typing new values directly into the parameter box.

By right clicking the mouse when positioned over the name of a specific Parameter or Group,
a pop-up menu appears allowing you to directly manage that particular parameter or group.

You can View the Selected Value for each parameter.
You can Restore the Default Value of each parameter or of all the parameters of a group.

Get Properties gives information about the parameter in the form of a pop-up hint that
describes the default value and the range/list of valid values.

The Short Help gives information about the parameter in the form of a pop-up hint.

EE Parameter Setup

Fil=: Cewvice Mode
Get | Send | Send Defaults | Permanent |
20 Codes ] 10 Codes ] Postal Codes ] Image Processing ] Mizcelaneous ]
Feading System Lavout ] E thernet ] Fieldbusz ] Dizplay ] Diagnosztics ]
Operating Modes ] Calg— ! — . LEDz And Keypad ]
Data Collection ] kM atch Parameter Group ] Communication ]
CODE COLLECTIOMN 7
Mumber OF Codes / 1
Code Callection Filkers / Dizabled
DATA FORMAT e
Code Field Juztification Dizabled
Code Field Cutting Dizabled
E Parameter '-.-'iLLv Selected Yalue
Statizticz Field Separator Sting ResreReanl kol Singl(rang:;lgzr[:lir:tmeter
Statiztics Field Farmat et Properties (right click)
Sumbalogy [dentifiers Short: Help
STATISTICS
Statuz Dizabled

Figure 118 - Editing Parameters
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Parameters to verify/modify:

Q

Operating Mode

Sets the parameters which customize the reader operating mode
starting from three main modes:

One Shot: acquires a single image based on the selected value
for the Acquisition Trigger and Acquisition Trigger Delay.

Continuous: continuously acquires images with a rate up to the
maximum allowable frame rate per second for the given sensor
depending on the decoding time and the Region of Interest
settings.

Phase Mode: acquires images during the reading phase
depending on the selected value for the Acquisition Trigger and
Acquisition Trigger Delay. The Reading Phase-ON and Reading
Phase-OFF events mark respectively the beginning and end of
the reading phase.

Q

Calibration

Calibrates the acquisition parameters to maximize the reading
performance (see par. 8.4.3).

Q

Communication

Configures the parameters relative to each serial port regarding
the transmission, message formatting and string receiving.

Any change to the VisiSet™ communication port parameters

(baud rate, data bits, etc.) is effective as soon as the reader is
disconnected from VisiSet™.

Ethernet

Sets the parameters related to the Ethernet interface and to its
communication channels.

Fieldbus

Sets the parameters related to the External Fieldbus interface
through the CBX500 and to its communication channels.

Display

Sets the Display language and Layout of the BM150 Display
when using the CBX500 connection box.

Diagnostics

Enables various diagnostic messages, formatting and actions.

Reading System Layout

Allows configuring the device according to the desired layout:
Standalone, ID-NET™ or Master/Slave RS232

Image Processing

Sets the image processing parameters shared by all available
symbologies.

1D & 2D, Postal Codes

Sets the characteristics of the code symbologies to be read.

Data Collection

Defines the code-collection parameters and the output message
format.

Digital I/O

Configures the reader input/output parameters.

Match Code

Allows setting a user-defined code and relative parameters to
which the read code will be compared (matched).

Q

Miscellaneous

Sets the reader name and the saved image format.

Q

Symbol Verification

Sets the parameters relative to the various specifications in the
Standards which regulate code validation.

Q

LEDs And Keypad

Sets the X-PRESS™ LED and Keypad parameters related to their
selected Functions: Beeper, Green Spot, Setup, Positioning, etc.
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When all the configuration parameters are set correctly, save them to the Matrix 400™
reader by pressing the Send button. See Figure 118.

For successive configuration of other readers or for backup/archive copies, it is possible to
save the configuration onto your PC by selecting the Save Configuration File option from
the File menu.

From the File menu, you can also Save Configuration As Text File for a human readable
version.

Load Configuration File (available in the File menu) allows you to configure a reader from a
previously saved configuration file (.ini).

8.4.2 Send Configuration Options

The device parameters are divided into two main classes, Configuration and Environmental
which are effected differently by the Send Configuration and Send Default Configuration
commands.

Configuration Parameters regard parameters that are specific to the device. These
parameters are influenced by the Send Configuration and Send Default Configuration
commands, that is they are overwritten by these commands. The same parameters are
modified by the following "Send Configuration with Options" and "Send Default Configuration
with Options" dialogs from the Device Menu:

EE Parameter Setup

Get Configuration )
[ nt | Interactive |
™ Send Configuration FE
2D send Configuration 'With Cptions b iing ] Miscellaneous ]
3] I Di ti
DE Send Default Configuration » 1 T’I Il |ag_n|:|sé.||:s {
! gend Default Configuration With Options » GIIHNIERNON
Op LEDs And Keypad |
OpEl  Select Mext Parameter Chrl+F1
0r Select Previous Parameter Chrl+F2
Reading Phaze OM Ext. Trig. Leading Edge
Acquigition Trigger Continuous
Reading Phaze OFF Ext. Trg. Traiing Edge
Image Acquisition Buffer Size 2
ACQUISITION TRIGGER DELSY 1
Status Dizabled

109



o MATRIX 400™ REFERENCE MANUAL

Environmental Parameters regard the device Identity and Position in a Network (ID-NET™,
Master/Slave RS232, MUX 32, Ethernet) and are not influenced by the "Send Default
Configuration" and "Send Configuration" commands. This allows individual devices to be
configured differently without affecting their recognized position in the network.

The following is a list of the Environmental Parameters:

READING SYSTEM LAYOUT
- Device Network Setting
- Number of Slaves

DEVICE NETWORK SETTINGS
- Topology Role

- ID-NET Slave Address

- Network Baud Rate

EXPECTED SLAVE DEVICES
- Status

- Device Description

- Device Network Name

MAIN PORT
- Communication Protocol
- Multidrop Address

ETHERNET SYSTEM
- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

- DNS1 Address

- DNS2 Address

MISCELLANEOUS

- Reader Name

- User Name

- Line Name

- Lens Type & S/N

- Internal Lighting System & S/N
- Diaphragm Aperture

- Focus Distance (mm)

110



SOFTWARE CONFIGURATION o

For device replacement it is necessary to send the previously saved configuration (both
Configuration and Environmental parameters) to the new device. To do this select "Send
Configuration with Options" from the Device Menu and check the Environmental Parameters

checkbox:

tH send Options &l

Do wouwantto send current configuration to device 7

Farameter Selection
[

v Enwviranment Parameters:

g/ es x Mo

In order to return a device to its absolute default parameters including Environmental
parameters, the following Send Default Configuration with Options" dialog must be used:

EE Send Defaults Options

Do wou want to restare default configuration to device ¢

Farameter Selection
[+

v Enviranment Parameters:

o Tes X Mo
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8.4.3 Calibration

VisiSet™ provides a Calibration Tool to maximize the reading performance by tuning the
acquisition parameters and the time of the delayed triggers.

By selecting the Calibration Tool from the VisiSet™ Main Menu (F), the following window
appears together with the Parameter Setup window:

EE Calibration Tool [E@I@

TenCell Stop Image Acquisition

" Dizabled

o After Any Capture
" On Mo Decode
" OnDecode

Screen Mode

" {» [Cecoded Image
i " Code Paosition Only
o

" Camera Mode

Arm Trigger |
8510 |

Yiew Image

Download Image |

B ottom,Right
Image Acquizition [nfarmation
Acquizition Setting: 1 Self Tuning: Dizabled
Expozure Time [x10us]: 35
Gair: 403
[Decoding Resultz
Symbalogy: Data katriw ECC 200 Selected Code: 1 —
Code Data: Datalogic 20 Code Reader
Code Center: [#.7]1=[811.6132)
Code Orientation: 1] Cluality Indesx:
Image Lighting Cluality
Exposure Index: | J Lighting Index:
Underexpozed 0k Owverexpozed
Statiztical information on the lazt 10 samples TH/RH

Figure 119 - Calibration OK

This tool provides a "real-time" image display while Matrix 400™ is reading. It also gives
immediate results on the performance of the installed Matrix 400™ reader.

The Parameter Setup window works in Interactive Mode in order to cause each parameter
setting to be immediately effective.

If you want to save the temporary configuration to permanent memory, you

must first close the Calibration Tool window. Then, you must disable the

Interactive Mode and select the Permanent Memory option from the Send
NOTE Configuration item in the Device menu.
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The following examples show some of the typical conditions occurring during the installation:

Under-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. increase the Exposure Time
2. increase the Gain

In general, a longer exposure time corresponds to a lighter image but is
susceptible to blurring due to code movement. Exposure time is also
limited by the Internal Lighting mode parameter. Longer esposure times
can be set if the power strobe level is lowered.

High gain settings may produce a grainy image that may affect the

NOTE decoding process.

it Calibration Tool nglrg‘ H parameter Setup E“E|&|
TopLeft - —_—
Stop Image Acquisition File Mode
&+ Disabled
 After Any Capture | | | | Interactive |
" OnMNoDecode
" OnDecode 2D Codes ] 1D Codes ] Postal Codes ] Image Processing ] Mizcellaneous ]
Screen Mods Data Collection ] Match Code ] S ymbol Yerification ] Communication ]
& Decoded Image Reading System Layout ] Ethernet ] Fieldbus ] Diizplay ] Diagnostics ]
2]  Code Pasiion Only Dperating Modes Calbration | Digtall/0 |  LEDsAndKepad |
' Eaemiikes IMAGE ACQUISITION SETTING 1
Statuz Enabled
Self Tuning Dizabled
Intemal Lighting Mode ‘Wery High-Power Strobed
Battam Right Q E=posure Time [210us] 10
Image Acquisition |nformation =
Acquisition Setting 1 Self Tuning; Disabled Ga!n - 0
Exposure Time (#10us): 10 Gair Increasing %1
Gain: 400 Image Polarity Inversion Disabled
Decoding Results Region OF Interest: Top 10
Symbology: Drata Matix ECC 200 Selected Code: Il ﬁ Fieion OF Interest: Bottorn 1209
Code Data: Datalogic 20 Code Reader Region OF1 Lo 10
Code Center, [¥.7]1=[799,580) egion nterest: Left
Code Orientation: 0 Quality Index: Region OF Interest: Right 1603
i o GLE Image Filter Dizabled

Exposure Indes:
Underexpozed oK,

Lighting Indes: =
Overexposed

Statistical information on the last 10 samples THAR=

Figure 120 - Example Under Exposure: Too Dark
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Over-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. decrease the Gain
2. decrease the Exposure Time

[ calibration Tool EE Parameter Setup

Topiieh Stop Image Acquisition File Mode

t¢ Disabled
" After Any Capture | | | |
 On Mo Decode

€ OnDecode 2D Codes ] 1D Codes ] Postal Codes ] Image Processing ] Miscellaneous ]

- - Screen Mode D ata Collection ] Match Code ] S ymbol Yerification ] Communication ]
¢+ Decoded Image Reading System Layout I Ethernet ] Fieldbus ] Diizplay ] Diagnostics ]
(" Code Position Only Operating Modes Calibration l Digital [/0 ] LEDs &nd Keypad ]
® Camem i IMAGE ACQUISITION SETTING 1

Status Enabled
Self Tuning Dizabled

Internal Lighting Mode Wery High-Power Strobed
Ettor Right g Exposure Time [210us) a0
Image Acquisition Information =
s ; ; Gain 750
Acquisition Setting: 1 Self Tuning: Dizabled
Exposure Time (x10us) 1] Gain Increasing «1
Gain: 750 Image Polarity Inversion Dizabled
Decoding Results Region OFf Interest: Top 10
> =] -
Symbalogy: Data Matriz ECC 200 Selected Code: h = Region OF Interest: Bottorn 1209
Code Data: Datalogic 20 Code Reader Region OF1 L 10
EotclEcne (3., ]=(79,579) R AT L
Code Orientation: 0 Guality Index: Region OF Interest: Right 1603
e e AU Image Filter Disabled
Expocure Index: Lighting Index: EEA
Underexposed oK Overexposed
Statiztical information on the last 10 samples TdRR

Figure 121 - Example Over Exposure: Too Light
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Moving code out of the Field of View:

To correct this result and have the code completely visible in F.O.V., it is possible to follow
one or both the procedures listed below:

e reposition the reader
e use the Acquisition Trigger Delay by tuning the Delay Time (x100us)

@ Calibration Tool
Top.Left

Image Acquisition |nformation

Image Lighting Cualty

Underexpozed

Decode %:

ok

Statistical infarmation on the last 10 samples

20%

Acquisition Setting 1

Exposure Time (1 0us): 30

Gair: 450

Decoding Results

Symbology: Diata Matix ECC 200

Code Data: Datalogic 2D Code Reader
Code Certer. [#.71=[1436 E73]
Code Orientation: 359

Exposure Index J_

Overexposed

FEX

Stop Image Acquisition
&+ Disabled

" After dny Capture
" OnNoDecode

" OnDecode

Screen Mode

& Decoded Image
e " Code Position Only
" Camera Made

Bottom,Right g

Self Tuning, Disabled
Selected Code: Il ﬁ
Quality Index: 0%

Lighting Index: .232

TA/RE

3] Close

EE Parameter Setup

Intemal Lighting Mode

ey High-Power Stobed

Exposure Time [x10us]

a0

Gain

450

Gain |ncreasing

x1

Image Polarity Inversion

Disabled

Fiegion OF Interest: Top

10

Fegion OF Interest: Bottom

1209

Region OF Interest: Left

10

Fiegion OF Interest: Right

1603

Image Filker

Disabled

File Mode
| _send | | |
2D Codes ] 1D Codes ] Postal Codes ] Image Processing ] Mizcellaneous I
[rata Collection l Match Code ] Symbol Verification Communication l
Feading System Layout ] Ethemet ] Fieldbus ] Dizplay ] Diagnostics ]
Operating Modes Calibration | Dighall/0 |  LEDs AndKeypad |
IMAGE ACQUISITION SETTING 1
Status Enabled
Self Tuning Disabled

Figure 122 - Example out of FOV
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8.4.4 Multi Image Acquisition Settings

When controlled variable conditions occur in the application, Multiple Image Acquisition
Settings (up to 10), can be defined to create a database of parameter groups that handle
each specific application condition. This database of pre-defined settings functions cyclically
and therefore automatically improves system flexibility and readiness.

For example, an application may have two stable but different lighting conditions which
require different lighting options. One Image Acquisition Setting could enable and use an
internal illuminator and a second setting could enable and use an external lighting system.
These two groups will be used cyclically on each acquisition in order to automatically capture
the correctly lighted image.

Image Acquisition Settings are found in the VisiSet™ Calibration parameter setup menu.
By selecting a different number and enabling its Status you can define the parameters for a
new group.

8.4.5 Run Time Self Tuning (RTST)

Run Time Self-Tuning (RTST) increases Matrix’s flexibility in the presence of uncontrolled
variable conditions (lighting, code contrast, etc.) by automatically adjusting its acquisition
parameters.

Self Tuning Calibration

In the Calibration parameter setup menu, the Self Tuning parameters manage the Image
Acquisition Setting parameters dynamically. Self Tuning provides automatic adjustment in
run time of different acquisition parameters (Exposure Time and/or Gain) for each captured
image based on calculations performed on previous acquisitions. These dynamic settings will
be used instead of the static settings saved in memory.

From to
Not Readable Readable

For more details see the Matrix 400™ Help On-Line.

Self Tuning Image Processing

In the Image Processing parameter setup menu, the Self Tuning parameters manage the
Image Processing and Symbology related parameters. They perform different processing
attempts on the same captured image according to the selected Self Tuning Mode parameter
value: (Symbologies Only, Processing Modes Only, Decoding Methods Only, Code Contrast
Levels Only, Image Mirroring Only, or General Purpose).

For more details see the Matrix 400™ Help On-Line.
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8.4.6 Region Of Interest Windowing

In order to satisfy very high throughput applications, higher frame rates can be achieved
using the powerful Region Of Interest Windowing parameters in the Calibration parameter
setup menu.

Region Of Interest Windowing allows defining a region or window within the reader FOV.
The Top, Bottom, Left and Right parameters allow to precisely define the image window to
be processed, visualized and saved.

In Matrix 400™ 600-0x0 models the frame rate is dependent on the number of lines (or rows)
in the defined window.

In Matrix 400™ 400-0x0 models the frame rate is dependent on the number of rows and
columns in the defined window.

The smaller the window, the lower the frame period and consequently the higher the frame
rate. In general the Image Processing time can be reduced by reducing the window
dimensions.

it Calibration Tool =15 | & parameter Setup
Veplat Stop Image Acquisitior File Mode
&+ Disabled
O fter Any Capture | | | | Interactive |
" OnMNoDecode
0.1 m
| # MalEsess D ata Callection ] Match Code ] Symbal Verification ] Communication ]
Screen Mods Feading System Layout ] Ethemet ] Fieldbus ] Diizplay ] Diagnostics ]
& Decoded Image 20 Codes ] 1D Codes ] Fostal Codes ] Image Processing ] Mizcellaneous ]
[ T " Code Fosiion Only Operating Modes Calibraton | Digtall/0 | LEDsAndKeypad |
0.20imm " Camera Mode IMAGE ACQUISITION SETTING 1
Status Enabled
° o
|H mu "" Self Tuning Disabled
Intemal Lighting Mode “Wery High-Power Strabed
Battam Right Q E=posure Time [x10us] 30
Image Acquisition |nformation -
Acquisition Setting 1 Self Tuning; Disabled Ga jrad
Exposure Time (#10us): a0 Gain Increasing %1
Gain: 450 Image Polarity Inverzion Dizabled
Decoding Results Region Of Interest: Top 300
: : | -
Symbology: Code 128 Selected Code: 1 = Region OF Interest: Bottom 900
Cade Data: 0.20 mm EY—— Lo 200
Code Center, [¥.¥]1=[793,600) eqion nterest: Left
Eapb et il Fegion OF Interest: Right 1300
Image Lighting Gualty EERALE] EEEE
Exposure Indes: Lighting Index:
Underexpozed oK, Overexposed
Statistical information on the last 10 samples THAR=
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8.4.7 Direct Part Marking Applications
Decoding Method: Direct Marking

For DataMatrix and QR code the Decoding Method parameter selects the decoding
algorithm according to the printing/marking technique used to create the symbol and on the
overall printing/marking quality. The Direct Marking selection improves the decode rate for
low quality Direct Part Mark codes and in general for Direct Part Mark codes with dot peening

type module shapes.

Washed out and Axial Dot Peening On

| ; Low Contrast
Distortion Scratched Surface Problem

Axial
distortion

. - A

Low contrast,
noisy background

Background Marked On Curved
Problems Shiny Surface

I:Ialf maeffects

Shiny surface,
noisy background

All the previous examples are successfully read selecting the Direct Marking Decoding
Method.
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Image Filter
Sets the filter to be applied to the image before being processed. This parameter can be
used to successfully decode particular ink-spread printed codes (ex. direct part mark codes).

A different filter can be applied to each Image Acquisition Setting.

The Erode Filter enlarges the image dark zones to increase readability.

Before - No Read After - Readable

Erode

The Dilate Filter enlarges the image white zones to increase readability.

-
-
-
-
-

-

-
-

-
-
-

Before - No Read After - Readable

Dilate

The Close filter eliminates dark areas (defects) in the white zones of the image.

The Open filter eliminates white areas (defects) in the dark zones of the image.
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8.5 IMAGE CAPTURE AND DECODING

By using the Capture Image and Decode Last Image functions from the VisiSet™ Main
menu, you can get information about the image decodable codes in terms of Symbology,
encoded Data, Position and Orientation, Decode Time and Code Quality Assessment Metrics.

EBX

File Edit Connect Disconnect Dewice Options Tools Help

Image captured (1600x1200) using Acquisition Setting #1 (Self
Tuning disabled).
*AkHRKARHARRAAKH Tmage Processing started (#1):

MATH MEHU

M. Setup Wizard

Hew Code (#1.1):

Symhology: Data Matrix ECC 200
Humber of Characters: 24

F. Calibration Tool

V. Symbol Verification
A. Run Mode
B. Capture Image

C. Decode Last Image

D. View Last Image

E. Download Last Image
H. Upload Bitmap Image
G. Store Match Code

Q. Image Buffer

3. Button Function Menu

Code Center Position: (805,604}
Pixel per Element: 10.6
Module Size: 24.0 mils € Focus Distance

Code Bounds: TL[679,485] TR[930,485] BL[679,723] BR[932,723]
Symhol Size: 20x20
Print Growth: 7%
Code Quali 3 100%
ISD-IEC 15415 Quality Indicators:
Overall Grade : A 4.0/18/660 (4)
Decode 8
Symbol Contrast a
Axial NWon Uniformity a
Unused Error Correction: A
Modulation : A
Fixed Pattern Damage a
Brid Non Uniformity a
Data: Datalogic 2D Code Reader

Image Exposure Quality: 80%

Image Processing Time (ms): 323

Fhkh A AR A AR A A4 R Tmage Processing completed (#1).

‘Connection: COSI00G20 on 172.16.11.12 Reader Status: OFF LINE MODE Log : OFF

Figure 123 - Capture and Decoding Functions

8.6 STATISTICS

Statistics on the reading performance can be viewed by enabling the Statistics parameter
and selecting the View Statistics item in the File menu. One of three different windows
appears depending on the operating mode.

Refer to the VisiSet™ Help On Line for more details.

EE Statistics

Total Samples
Acquisiion Counter:
Complete Read Counter:

Complete Reads [%]:

Last Samples
Acquisition Counter:
Complete Fead Counter:

Complete Reads [%]:

Reading Performance

Max Decoding Time [ms]:

Frame R ate (Images/z):

Last Decoded Code
Syrbalogy:
Code Data

Mean Decading Time [ms):

1000
1000
100.00

100.00

22
22

[rata Matrix ECC 200
[ratalogic 20 Code Reader

Reset |

Figure 124 - Code Statistics
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9 MAINTENANCE

9.1 CLEANING

Clean the reading window (see Figure A, 1) periodically for continued correct operation of the
reader.

Dust, dirt, etc. on the window may alter the reading performance.
Repeat the operation frequently in particularly dirty environments.

Use soft material and alcohol to clean the window and avoid any abrasive substances.
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10 TROUBLESHOOTING

10.1 GENERAL GUIDELINES

e When wiring the device, pay careful attention to the signal name (acronym) on the
CBX100/500 spring clamp connectors (chp. 4). If you are connecting directly to the
Matrix 400™ M16 19-pin connector pay attention to the pin number of the signals (chp. 5).

 If you need information about a certain reader parameter you can refer to the VisiSet™
program help files. Either connect the device and select the parameter you're interested in
by pressing the F1 key, or select Help>Paramters Help from the command menu.

e If you're unable to fix the problem and you’re going to contact your local Datalogic office or
Datalogic Partner or ARC, we suggest providing (if possible): Application Program version,
Parameter Configuration file, Serial Number and Order Number of your reader. You can
get this information while VisiSet™ is connected to the reader: the Application Program
version is shown in the Terminal Window; the Parameter Configuration can be saved to an
.ini file applying the File>Save Configuration File command in the Parameter Setup
window; Serial Number and Order Number can be obtained by applying the respective
command in the Tools menu.

TROUBLESHOOTING GUIDE

Problem Suggestion

Power ON: e |s power connected?

the “POWER” LED is not lit. o If using a power adapter (like PG6000), is it connected
to wall outlet?

o If using rail power, does rail have power?

 Ifusing CBX, does it have power (check switch and
LED)?

e Check if you are referring to the M16 19-pin connector
or to the CBX spring clamp connectors.

o Measure Voltage either at pin A and pin L (for 19-pin
connector) or at spring clamp Vdc and GND (for CBX).

One Shot or Phase Mode |« Check if you are referring to the 19-pin connector or to

using the Input 1 (External the CBX spring clamp connectors.

Trigger) or Input 2: e Is the sensor connected to the Input 1 or Input 2?

the "TRIGGER” LED is not |e Is power supplied to the photo sensor?

blinking while the External |¢ For NPN configuration, is power supplied to one of the

Trigger is switching. two 11 or 12 signals (A or B)?

o For PNP configuration, is one of the two |1 or 12 signals
grounded (A or B)?

o Are the photo sensor LEDS (if any) working correctly?

e Is the sensor/reflector system aligned (if present)?

« In the Digital I/O folder check the EXTERNAL
TRIGGER or INPUT 2\Debounce Filter parameter
setting.

e In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

One Shot or Phase Mode
using serial trigger source:
the "TRIGGER” LED is not
blinking.

¢ In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.

e Are the COM port parameters (Baud Rate, Parity, Data
Bits, Stop Bits, Handshake) correctly assigned?

¢ In the communication folder, check the settings of
Reading Phase-ON String, Acquisition Trigger
String and Reading Phase-OFF String parameters.

 Is the serial trigger source correctly connected?

Phase Mode:

the ’"TRIGGER" LED is
correctly blinking but no image
is displayed in VisiSet™
Calibration Tool window.

e Is the Phase frequency lower than the maximum frame
rate?

Continuous Mode:
the "TRIGGER” LED is not
blinking.

o Verify the correct software configuration settings.

Any Operating Mode:

the "TRIGGER” LED is
correctly blinking but no result
is transmitted by the reader at
the end of the reading phase
collection.

¢ In the Data Collection folder check the settings for the
CODE COLLECTION, DATA FORMAT and
STATISTICS parameter groups.

Image not clear:

 verify the Focus procedure

Image focused but not
decoded:

o verify the Calibrate Image Density prodcedure.

Reading:
the reader always transmits
the No Read Message

e Run the Rapid Configuration procedure in chapter 1.
» Position the reader as described in par. 3.3 and through
the VisiSet™ Calibration Tool:
— Tune the ACQUISITION TRIGGER DELAY, if the
moving code is out of the reader field of view;
— Set the Continuous Operating Mode if no external
trigger source is available;
— Tune the IMAGE ACQUISITION SETTING to
improve the code image quality;
— Check the parameter setting in Decoding,
2D Codes, 1D Codes, and Postal Codes folders;
— View the full resolution code image to check the
printing or marking quality.

Communication:
reader is not transmitting
anything to the host.

e Is the serial cable wiring correct?

o If using CBX, be sure the RS485 termination switch is
OFF.

e Are the host serial port settings the same as the reader
serial port settings?

e In VisiSet™ Digital I/0 folder, "COM" LED can be
configured to indicate MAIN COM port TX or MAIN
COM port RX.

Communication:
data transferred to the host

o Are the host serial port settings the same as the reader
serial port settings?
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TROUBLESHOOTING GUIDE

Problem

Suggestion

are incorrect, corrupted or
incomplete.

In VisiSet™ Communication folder check the settings of
Header and Terminator String parameters.

In VisiSet™ Data Collection folder, check the settings of
DATA FORMAT parameter group.

How do | obtain my reader
Serial Number?

The reader Serial Number consists of 9 characters: one
letter, 2 numbers, another letter followed by 5 numbers.
The reader Serial Number is printed on a label that is
affixed on the bottom case near the reading window.
The Serial Number can also be obtained by selecting
Tools/Get Reader Serial Number from the command
menu in VisiSet™. A dedicated window will appear.

How do | obtain my reader
Order Number?

The reader Order Number consists of 9 numbers.

The reader Order Number can be obtained by selecting
the Tools/Get Reader Order Number from the command
menu in VisiSet™. A dedicated window will appear.
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11 TECHNICAL FEATURES

ELECTRICAL FEATURES

Power
Supply Voltage
Power Consumption

10 to 30 Vdc
0.81t00.27 A, 8 W max.; 0.5t0 0.17 A, 5 W typical

Communication Interfaces
Main

- RS232

- RS485 full-duplex

- RS485 half-duplex
Auxiliary - RS232

2400 to 115200 bit/s
2400 to 115200 bit/s
2400 to 115200 bit/s
2400 to 115200 bit/s

Output 1 and Output 2

ID-NET™ Up to 1MBaud

Ethernet (Ethernet Models only) 10/100 Mbit/s

Inputs

Input 1 (External Trigger) and Input 2 Opto-coupled and polarity insensitive
Max. Voltage 30 Vdc

Max. Input Current 10 mA

Outputs

Opto-coupled

Vout (ILoas = 0 MA) Max. 30 Vdc
Vout (ILeas = 10 MA) Max. 1.8 Vdc
Po = Vout X lLoag Max. 170 mW

OPTICAL FEATURES

4xx-xxx models 6xx-xxx models

Image Sensor CMOS CCD

Image Format SXGA (1280x1024) UXGA (1600x1200)
Frame Rate 27 frames/sec. 15 frames/sec.
Pitch +35°

Tilt 0° - 360°

Lighting System

Internal or External llluminator (accessories)

LED Safety Class

Class 1 to EN60825-1

ENVIRONMENTAL FEATURES

Operating Temperature

0 to 50 °C (32 to 122 °F)

(high ambient temperature applications should use metal mounting bracket for
heat dissipation)

Storage Temperature

-20 to 70 °C (-4 to 158 °F)

Max. Humidity 90% non condensing

Vibration Resistance 14 mm @ 2 to 10 Hz; 1.5 mm @ 13 to 55 Hz;
EN 60068-2-6 2 g @ 70 to 200 Hz; 2 hours on each axis
Bump Resistance 30g; 6 ms;

EN 60068-2-29 5000 shocks on each axis

Shock Resistance 30g; 11 ms;

EN 60068-2-27 3 shocks on each axis

Protection Class P67 *

EN 60529

PHYSICAL FEATURES

Dimensions 123 x 60.5 x 87 mm (4.85 x 2.38 x 3.43 in.) with lens cover
Weight 482 g. (17 oz.) with lens and internal illuminator
Material Aluminium

* when correctly connected to IP67 cables with seals and the Lens Cover is correctly mounted.
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SOFTWARE FEATURES

Readable Code Symbologies

1-D and stacked 2-D POSTAL
e PDF417 Standard and Micro PDF417 e Data Matrix ECC 200 o Australia Post
o Code 128 (EAN 128) (Standard and Direct Marking) o Royal Mail 4 State Customer
e Code 39 (Standard and Full ASCII) ¢ QR Code e Kix Code
e Interleaved 2 of 5 (Standard and Direct Marking) o Japan Post
e Codabar ¢ MAXICODE e PLANET
e Code 93 e Aztec Code e POSTNET
e Pharmacode e Microglyph e POSTNET (+BB)
e EAN-8/13 - UPC-A/E (this symbology requires an|e Intelligent Mail
(including Addon 2 and Addon 5) activation procedure — contact your
o GS1 DataBar (RSS) Family local Datalogic Automation
e Composite Symbologies distributor for details)

Operating Mode

ONE SHOT, CONTINUOUS, PHASE MODE

Configuration Methods

X-PRESS™ Human Machine Interface
Windows-based SW (VisiSet™) via serial or Ethernet link
Serial Host Mode Programming sequences

Parameter Storage

Permanent memory (Flash)

CODE QUALITY VERIFICATION

Standard

Supported Symbologies

ISO/IEC 16022
ISO/IEC 18004
ISO/IEC 15415
ISO/IEC 15416
AS9132A
AIM DPM

Data Matrix ECC 200

QR Code

Data Matrix ECC 200, QR Code

Code 128, Code 39, Interleaved 2 of 5, Codabar, Code 93, EAN-8/13, UPC-A/E
Data Matrix ECC 200

Data Matrix ECC 200, QR Code

USER INTERFACE

LED Indicators

Power, Ready, Good; Trigger; Com, Status, (Ethernet Network); (Green Spot)

Keypad Button

Configurable via VisiSet™
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AIM
(Association for Automatic Identification and Mobility): AIM Global is the international trade
association representing automatic identification and mobility technology solution providers.

AIM DPM Quality Guideline

Standard applicable to the symbol quality assessment of direct part marking (DPM)
performed in using two-dimensional bar code symbols. It defines modifications to the
measurement and grading of several symbol quality parameters.

AS9132
Standard defining uniform quality and technical requirements for direct part marking (DPM)
using Data Matrix symbologies.

Barcodes (1D Codes)

A pattern of variable-width bars and spaces which represents numeric or alphanumeric data
in machine-readable form. The general format of a barcode symbol consists of a leading
margin, start character, data or message character, check character (if any), stop character,
and trailing margin. Within this framework, each recognizable symbology uses its own unique
format.

BIOS
Basic Input Output System. A collection of ROM-based code with a standard API used to
interface with standard PC hardware.

Bit

Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits
compose one byte of data. The pattern of 0 and 1 values within the byte determines its
meaning.

Bits per Second (bps)
Number of bits transmitted or received per second.

Byte

On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to
represent a specific character or numeric value. Bits are numbered from the right, 0O through
7, with bit 0 the low-order bit. One byte in memory can be used to store one ASCII character.

Composite Symbologies
Consist of a linear component, which encodes the item's primary data, and an adjacent 2D
composite component, which encodes supplementary data to the linear component.

Dark Field lllumination
Lighting of surfaces at low angles used to avoid direct reflection of the light in the reader’s
lens.

Decode
To recognize a barcode symbology (e.g., Codabar, Code 128, Code 3 of 9, UPC/EAN, etc.)
and analyze the content of the barcode scanned.
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Depth of Field
The difference between the minimum and the maximum distance of the object in the field of
view that appears to be in focus.

Diffused lllumination
Distributed soft lighting from a wide variety of angles used to eliminate shadows and direct
reflection effects from highly reflective surfaces.

Direct Part Mark (DPM)
A symbol marked on an object using specific techniques like dot peening, laser etching,
chemical etching, etc.

EEPROM
Electrically Erasable Programmable Read-Only Memory. An on-board non-volatile memory
chip.

Element
The basic unit of data encoding in a 1D or 2D symbol. A single bar, space, cell, dot.

Exposure Time
For digital cameras based on image sensors equipped with an electronic shutter, it defines
the time during which the image will be exposed to the sensor to be acquired.

Flash
Non-volatile memory for storing application and configuration files.

Host

A computer that serves other terminals in a network, providing services such as network
control, database access, special programs, supervisory programs, or programming
languages.

Image Processing
Any form of information processing for which the input is an image and the output is for
instance a set of features of the image.

Image Resolution
The number of rows and columns of pixels in an image. The total number of pixels of an
image sensor.

Image Sensor
Device converting a visual image to an electric signal. It is usually an array of CCD (Charge
Coupled Devices) or CMOS (Complementary Metal Oxide Semiconductor) pixel sensors.

IEC
(International Electrotechnical Commission): Global organization that publishes international
standards for electrical, electronic, and other technologies.

IP Address

The terminal’s network address. Networks use IP addresses to determine where to send
data that is being transmitted over a network. An IP address is a 32-bit number referred to as
a series of 8-bit numbers in decimal dot notation (e.g., 130.24.34.03). The highest 8-bit
number you can use is 254.
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ISO
(International Organization for Standardization): A network of the national standards
institutes of several countries producing world-wide industrial and commercial standards.

LED (Light Emitting Diode)
A low power electronic light source commonly used as an indicator light. It uses less power
than an incandescent light bulb but more than a Liquid Crystal Display (LCD).

LED Illluminator
LED technology used as an extended lighting source in which extra optics added to the chip
allow it to emit a complex radiated light pattern.

Matrix Symbologies (2D Codes)

An arrangement of regular polygon shaped cells where the center-to-center distance of
adjacent elements is uniform. Matrix symbols may include recognition patterns which do not
follow the same rules as the other elements within the symbol.

Multidrop
A communication protocol for connecting two or more readers in a network with a
concentrator (or controller) and characterized by the use of individual device addresses.

Multi-row (or Stacked) Symbologies
Symbologies where a long symbol is broken into sections and stacked one upon another
similar to sentences in a paragraph.

RAM
Random Access Memory. Data in RAM can be accessed in random order, and quickly
written and read.

Symbol Verification
The act of processing a code to determine whether or not it meets specific requirements.

Transmission Control Protocol/Internet Protocol (TCP/IP)

A suite of standard network protocols that were originally used in UNIX environments but are
now used in many others. The TCP governs sequenced data; the IP governs packet
forwarding. TCP/IP is the primary protocol that defines the Internet.
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